Thank You For Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. Our mission is to:

1. Provide a Superior Customer Experience
   - offer the best product quality and support
2. Make Cool Practical Technology
   - develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers' requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. *If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.*)
are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

TechSmith® and Camtasia® are either registered marks or marks of TechSmith Corporation in the U.S. and/or other countries.

ATI is a trademark of Advanced Micro Devices, Inc.

The Miro name, logo, and icon are trademarks of the Participatory Culture Foundation (PCF).

VMware, the VMware logo, VMware Cloud Foundation, VMware Cloud Foundation Service, VMware vCenter Server, and VMware vSphere are registered trademarks or trademarks of VMware, Inc. or its subsidiaries in the United States and/or other jurisdictions.

SEGA and the SEGA logo are either registered trademarks or trademarks of the SEGA Holdings Co., Ltd or its affiliates.

Dolby, Dolby Audio, and the double-D symbol are trademarks of Dolby Laboratories.

**FCC Compliance and User Information**

The following information has been provided to clarify FCC requirements for operation of this device. These requirements are found in the FCC rules for radio frequency devices, Part 15.

**Compliance**

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense.

**Important - Modifications & Shielded Cables**

Changes or modifications to this product not authorized by Ross® Video Limited could void the FCC Compliance and negate authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Ross® Abekas® peripheral devices and Ross® Abekas® shielded cables and connectors between system components. It is important that Ross® Abekas® peripheral devices are used, and shielded cables and connectors are used between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices. Ross® Abekas® peripheral devices and the properly shielded cables and connectors can be obtained directly from Ross® Abekas®, or through a Ross® Abekas®-authorized dealer.

**EMC Notices**

**Canada**

This Class “ A ” digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe “ A ” est conforme à la norme NMB-003 du Canada.

**Europe**

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

⚠️ **Important:** This equipment is compliant with Class A of CISPR32. In a residential environment this equipment may cause radio interference.
Australia

This equipment has been tested to AS/NZS CISPR 22:2009 +A1:2010 and found to comply with the limits for a Class A Digital device.

International

This equipment has been tested to CISPR 22:2008 and found to comply with the limits for a Class A Digital device.

Important: This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Safety and First Aid

Ross® Abekas® equipment is designed to the highest standards of quality and reliability. However, no matter how these systems are designed, operators and maintenance personnel can be exposed to electrical shock hazard when protective covers are removed for maintenance or the installation of options. With this caution in mind, each operator and engineer must observe all safety regulations, and have a clear understanding of first aid procedures related to electrical hazards.

Safety and Compliance Certifications

- Certified to IEC/EN-60065, EN-55032, and EN-55024

Power Information

To ensure safe operation and to guard against potential shock or risk of fire, ensure your AC power source for the system is within the required voltage range and frequency.

- AC Voltage Input (Auto-Ranging): 100VAC through 240VAC
- Input AC Frequency Range (nominal) 60Hz — 50Hz
- Input AC Power Requirement at 110VAC: ~3.5A Maximum
- Input AC Power Requirement at 240VAC: ~1.5A Maximum

Operating Environment

The optimum operating environment is within the following ranges:

- Recommended Operating Temperature: 13°C to 35°C (55°F to 95°F)
- Recommended Operating Humidity: 20% to 80% non-condensing

Note: High temperature/humidity should be avoided at all times.

Safety Information

Important Safety Notices

This system complies with safety standard IEC/EN60065. To ensure safe option and to guard against potential shock hazard or risk of fire, the following must be fulfilled:

- This system features auto-ranging power supplies. Ensure that your power source is within the correct range of voltage and frequency, as required by the system.
- Each chassis in this system must be electrically grounded by connecting the input power cord(s) to a correctly wired and grounded power outlet.
• For ventilation, the front and rear of the unit must have minimum clearance of 4 inches, except for cables. No newspapers, tablecloths, curtains, etc. shall block the vents. No naked flames, such as candles shall be placed on the apparatus.
• This equipment shall not be exposed to splashing or dripping liquids. No objects filled with liquids, such as vases shall be placed on the equipment.

**Warning:** Completely disconnect all input AC power cords from the chassis before removing the top cover from the chassis. Failure to do so will expose dangerous electric currents and voltages. Physical contact with these electric currents and voltages is extremely dangerous and may result in severe physical injury or death! Only qualified service personnel should remove the top cover from the chassis.

**Warning Hazardous Voltages:** Modules marked with this symbol may be removed while the system is operating (powered). After removing a module, beware of dangerous electric currents and voltages that are exposed on the module receptacle connector inside the chassis. Please keep fingers, tools, and foreign metal objects away from the exposed receptacle connector while the chassis has input AC power applied. Physical contact with these electric currents and voltages is extremely dangerous and may result in severe physical injury or death! Only qualified service personnel should remove these modules.

### Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

### Company Address

**Ross Video Limited** — 8 John Street Iroquois, Ontario, Canada, K0E 1K0

**Ross Video Incorporated** — P.O. Box 880, Ogdensburg, New York, USA, 13669-0880

General Business Office: (+1)613-652-4886
Fax: (+1)613-652-4425
Toll Free Technical Support (North America): 1-844-652-0645
Toll Free Technical Support (International): +800 1005 0100
Technical Support: (+1)613-652-4886
After Hours Emergency: (+1)613-349-0006

E-Mail (Support): techsupport@rossvideo.com
E-Mail (General): solutions@rossvideo.com
Website: www.rossvideo.com
Technical Support

At Ross Video, we take pride in the quality of our products, but if a problem does occur, help is as close as the nearest telephone.

Our 24-Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support are provided directly by Ross Video personnel. During business hours (eastern standard time), technical support personnel are available by telephone. Outside of normal business hours and on weekends, a direct emergency technical support phone line is available. If the technical support personnel who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. Our Technical support staff are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.
Contents

Getting Started.........................................................................................................................................................................................12
  Power On/Off.........................................................................................................................................................................................12
  Windows® Login...................................................................................................................................................................................12
  Software............................................................................................................................................................................................12

Server Configuration.....................................................................................................................................................................................13
  Channel Setup.......................................................................................................................................................................................13
    To Configure the Hardware Channels...........................................................................................................................................13
  Video Formats.....................................................................................................................................................................................13
    To Configure the Video Format.......................................................................................................................................................13
  Video Router Setup..............................................................................................................................................................................14
    To Connect to a Video Router......................................................................................................................................................14
  Audio Setup.......................................................................................................................................................................................15
    To Configure the Audio Setup.....................................................................................................................................................15
  Audio Router Setup.............................................................................................................................................................................16
    To Configure the Audio Router...............................................................................................................................................16
  Timecode Setup..................................................................................................................................................................................18
    To Configure the Timecode......................................................................................................................................................18
  Channel Label Setup.........................................................................................................................................................................19
    To Assign Labels to Channels....................................................................................................................................................19
  Count Down Display...........................................................................................................................................................................20
  TSL Tally Setup................................................................................................................................................................................20
    To Configure the TSL Tally Input...............................................................................................................................................21

Replay Setup............................................................................................................................................................................................22
  Control Surface Connection..........................................................................................................................................................22
  Server Setup for Replay..............................................................................................................................................................22
  User Setup.......................................................................................................................................................................................23
    To Set the Audio Tracks for the Headphones..........................................................................................................................23
    To Set the Play List Auto-fill....................................................................................................................................................23
    To Set the Pre-roll Time..........................................................................................................................................................24
    To Set the Auto Jog Feature...................................................................................................................................................24
    To Set the Default Fast Forward and Rewind Speeds................................................................................................................25
    To Set the Max Jog Speed.....................................................................................................................................................25
    To Set the Max Fast Jog Speed...........................................................................................................................................25
    To Set the Max Cruise Speed...............................................................................................................................................26
    To Set the Max Fast Cruise Speed........................................................................................................................................26
    To Set the Max T-Bar Speed (VAR 2)........................................................................................................................................26
    To Set the Min T-Bar Speed (VAR 2)........................................................................................................................................27
    To Set the Max T-Bar Speed (VAR 3)........................................................................................................................................27
    To Set the Min T-Bar Speed (VAR 3)........................................................................................................................................28
    To Set the Auto-mark In-point Offset........................................................................................................................................28
    To Set the Auto-mark Out-point Offset..................................................................................................................................28
    To Set the Action of Camera Softkeys in CP Mode..................................................................................................................29
    To Set the Transition Type for Two Replay Channels.......................................................................................................29
    To Set the Duration of a Mix Transition....................................................................................................................................30
    To Set Whether Gang Mode is Selected for Live EE Record................................................................................................30
    To Set Whether Gang Mode is Deselected if a Playout Channel is Selected...........................................................................30
    To Set Whether Preferred Camera Angles are Used for Live EE Record................................................................................31
    To Set the Preferred Camera Angles.......................................................................................................................................31
    To Set the Preferred Play List................................................................................................................................................31
    To Set Whether a Clip is Automatically Loaded in CP Mode................................................................................................32
    To Set Whether the Out-point of a Clip is Used in CP Mode....................................................................................................32
    To Set Whether Play List uses PGM/PW.....................................................................................................................................33
To Create a Child Clip................................................................. 75
Deleting a Clip.................................................................................. 76
To Delete a Clip............................................................................... 76
Lock/Unlock Clips........................................................................... 76
To Lock/Unlock a Clip................................................................. 76
Timecode Chase........................................................................... 77
To Create a TC Chase List......................................................... 77
To Air a TC Chase List............................................................. 78

Replay Overview........................................................................ 79
Required Equipment..................................................................... 79
Control Surface............................................................................. 79
Softkey Buttons and Shift............................................................ 80
T-Bar Area...................................................................................... 81
Clip Control Area......................................................................... 81
Navigate Area............................................................................... 82
Live EE Area................................................................................. 82
Play List Area............................................................................... 83
Output Control Area................................................................. 83
Rotary Dial Area.......................................................................... 84
Play Back Area............................................................................ 85
Replay Window............................................................................. 85
Playout Channels......................................................................... 86
Camera Inputs................................................................................ 86
Lists and Menu............................................................................... 87
Softkeys........................................................................................ 87
Modes of Operation..................................................................... 87
Live EE Mode.............................................................................. 87
Playback Mode............................................................................ 88
Clip Play Mode............................................................................. 88
Play List Mode............................................................................ 89
Vue Mark Mode........................................................................... 89

Replay Events............................................................................. 90
To Create/Edit a Replay Event................................................... 90
To Open a Replay Event on a Control Surface........................... 92
To Open an Existing Replay Event from a Control Surface.......... 93
To Create/Edit a Replay Event Template................................... 93

Replay Operation....................................................................... 94
Loading Server Clips................................................................. 94
To Import a Clip from the Clip Library........................................ 94
Capture a Replay Event............................................................. 94
To Put a Playout Channel in Live Record (EE) Mode................... 94
To Capture an Event for Live Replay......................................... 95
Playback...................................................................................... 96
To Playback an Event from Live Record.................................... 96
Clipping...................................................................................... 97
To Save a Clip to the Clip Register............................................ 97
To Name a Clip........................................................................... 97
To Load a Clip from the Clip Register........................................ 98
To Trim a Clip............................................................................. 99
Play List...................................................................................... 99
To Create a Play List............................................................... 99
To Name a Play List............................................................... 100
To Edit a Play List...................................................................... 100
To Copy and Paste Play List Items........................................... 101
To Enable Aux Audio for a Play List.......................................... 102
To Air a Play List....................................................................... 103
Getting Started

The server consists of a single 2RU chassis that contains all of the video/key/audio processing hardware and a removable SSD for media storage. The server runs a standard Microsoft® Windows® operating system with the pre-installed Abekas® software applications for interacting with the video processing hardware.

Power On/Off

The system powers on with the single power button located at the front of the chassis. When the power button is pressed the system will boot up and launch Windows®.

⚠️ Warning: Even with the system powered off, hazardous voltages are present inside the chassis. Disconnect both the primary and secondary power supplied before opening up the chassis.

Windows® Login

The server comes with the Microsoft® Windows® operating system and all the required software pre-installed.

Refer to the Windows® help system for information on changing the password.

Note: Once you have logged in to the system, the video channels and serial control are all active. If you are using an external serial controller, that controller can now be used to control the video channels (including loading and playing clips).

Software

The server comes pre-installed with all the software needed for operation and setup.

- **Mira Explorer** — provides a graphical interface to the operation of the server.
- **Mira Import** — allows you to import media files into the server.
- **Mira Config** — allows you to configure the hardware of the server.
Server Configuration

The Mira Config application allows you to configure various aspects of the hardware in your server. The number of channels and inputs and outputs you have depend on the hardware installed in your server.

⚠️ Important: Not all settings are available on all servers or require an option to be purchased or installed.

Note: Not all of the settings are required for replay operation.

Channel Setup

The hardware channels can be set up in a number of ISO (playback) modes, depending on the number of cameras you want to use for your replay event.

*Table 1: ISO / Replay Modes*

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO-1</td>
<td>A single record channel (camera) with two (2) playout channels.</td>
</tr>
<tr>
<td>ISO-2</td>
<td>Two (2) record channels (cameras) with (2) playout channels.</td>
</tr>
<tr>
<td>ISO-3</td>
<td>Three (3) record channels (cameras) with (2) playout channels.</td>
</tr>
<tr>
<td>ISO-4</td>
<td>Four (4) record channels (cameras) with (2) playout channels.</td>
</tr>
</tbody>
</table>

To Configure the Hardware Channels

The number of hardware channels on your server depends on the configuration you purchased.

1. Launch the Mira Config application.
   You may be prompted to allow the program to make changes on the computer, click Yes.
2. Click the Channels tab.
3. Select the ISO mode you want to use.
4. Click Apply.

Video Formats

Select the video format that the server is operating in, and the source of the reference signal.

To Configure the Video Format

The server can only operate in one video format at a time. All channel transports will play and record in the same format.

Note: Not all video resolutions and frequencies are compatible. Some selections will be grayed out if they are not compatible.

1. Launch the Mira Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Video tab.

3. In the Video Reference Frequency area, select the frequency you want the server to operate in.
4. In the Video Resolution area, select the video resolution you want the server to operate in.
5. In the Video Reference Source area, select the type of input reference signal that the server is using. This is the video signal that is connected to the REF IN HD-BNC on the back of the server.

   Note: You should only use Free Run when the server is not receiving video from, or outputting video to, another device.

   Important: If you select Tri-Level External Reference or Bi-Level External Reference with no valid reference signal coming into the server, you will get corrupt video on all outputs.

6. In the Horizontal Phase area, select a timing offset for the video output relative to the reference timing.
7. Click Restart Mira. A confirmation dialog box is displayed.
8. Click Restart Mira to restart the server application and services with the new setting.
9. Click OK when the restart has completed to dismiss the window.

**Video Router Setup**

You can connect the server to an external router and control the sources feeding the server.

   Note: The router must support the Evertz® Quartz or Probel SW-P-08 protocol.

**To Connect to a Video Router**

You can change which destinations are coming into the server from the router, as well as which sources on the router are routed to those destinations.

1. Launch the Mira Config application.
   
   You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Video Router tab.
3. In the **Router Protocol** area, select the protocol you want to use to communicate with the router.
   - **Probel SW-P-08** — select this option if your router uses the Snell Advanced Media® SW-P-08 protocol.
   - **Quartz** — select this option if your router uses the Evertz® Quartz protocol.

4. In the **Router Levels** field, select the number of levels that the router is using.

5. In the **Router IP Address** field, enter the IP address of the router you want to control.

6. In the **Router Port Number** field, enter the port on the router you want to connect to.

7. Click **Connect to Router** to connect to the router.

8. In the **Video Router Destinations** area, select which destinations on the router are connected to each video channel input on the server. This is the physical connection from one BNC to the other.

9. In the **Change Router Sources** area you can change which sources are being routed to the destinations that are assigned to each video channel input on the server.

   **Tip:** Router sources can also be changed in a replay event using the Control Surface.

10. Click **Apply**.

### Audio Setup

You can select the number of audio tracks to record, which sources audio will use, and which audio channel to monitor from the analog audio output headphone jack. The number of AES digital audio inputs and outputs depends on the model of server you purchased.

**To Configure the Audio Setup**

Select the number of tracks to record and which tracks are sent to the headphones jacks.

1. Launch the **Mira Config** application.
   
   You may be prompted to allow the program to make changes on the computer, click **Yes**.

2. Click the **Audio** tab.
3. In the **Audio Tracks** area, select the number of audio tracks to record.
   - **2 track audio** — record two tracks of audio.
   - **4 track audio** — record four tracks of audio
   - **8 track audio** — record eight tracks of audio. This option is not available when the server is operating in an SD video format (525/480i or 625/576i).
   - **16 track audio** — (software option) record sixteen tracks of audio. This option is not available when the server is operating in an SD video format (525/480i or 625/576i).

4. In the **Audio Tracks in an ISO Clip** area, select the number of audio tracks to record per input channel.

5. In the **Audio Muting Policy** area, select how the audio output (AES, embedded, and analog audio out) is muted during playback.
   - **Mute everything except 100% play speed and JOG STEP** — audio is muted at all play speeds except 1× (100%) and during single-frame jogging.
   - **Mute everything except 100% play speed. Mute JOG STEP** — audio is muted at all play speeds except 1× (100%).
   - **Mute when speed is not in the range 85% through 115% of play speed** — audio is muted at all play speeds except in the range of 85% to 115% play speed.
   - **Mute when playback speed exceeds 200% play speed.** — audio is muted only when play speed exceeds 2× (200%).

6. In the **Analog Audio Monitor** area, select the channel transport audio that you want to monitor on the analog audio output headphone jack. Only audio tracks 1 and 2 are available on the analog audio output port.

7. Click **Apply**.

### Audio Router Setup

There are two integrated audio routers built into the server. An input router that sends audio from an audio input to any channel transport, and an output router that sends the audio from a channel transport to any audio output. The number of audio inputs and outputs depends on the options you have installed in your server.

Audio sources and destinations include embedded audio and AES audio on the TASCAM® AES-59 DB25 ports on the back of the server.
To Configure the Audio Router

The Audio Input Router tab allows you to set the audio tracks that get recorded on the server and the Audio Output Router tab allows you to set which audio tracks are played from the server.

1. Launch the Mira Config application.
   You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Audio Router tab.
   Tip: If the audio routing on an input or output has been changed, a dot is shown next to the name on the tab.

3. Click the Audio Input Router tab.

4. Click on the tab for the record channel that you want to route audio tracks to.

5. In the REC-X Recorder Track 1 row, select the source channel input (REC-X Input) and the audio track (Track #) from the input that you want to record on track 1 of the clip.

6. Repeat this step for all of the remaining recorder tracks.
7. Click the **Audio Output Router** tab.

![Image of Audio Output Router](image)

8. Click on the tab for the channel output into which you want to route audio tracks.

9. In the **PGM-X Audio Output Track 1** row, select the source channel player (**PGM-X Player**) and the audio track (**Track #**) from the player that you want to route to track 1 of the output video stream.

10. Repeat this step for all of the remaining output tracks and channel outputs.

   *Tip: Click **NORMANIZE ALL PGM-X Output Routes** to reset all the player audio track to their default output track assignment.*

11. Click **Apply**.

**Timecode Setup**

The timecode information can be overlaid on the output video stream of the server. This can be time of day linear timecode (LTC) coming into the server, or the embedded ancillary timecode (ATC) in the video stream being recorded.

*Important:* When you turn the timecode overlay on, it is shown over the image on the video output.

**To Configure the Timecode**

The timecode information can be overlayed on the output video stream of the server.

*Note:* The timecode overlay is only on the video output and will not appear in the recorded video.

1. Launch the **Mira Config** application.

   You may be prompted to allow the program to make changes on the computer, click **Yes**.

2. Click the **Timecode** tab.
3. In the Timecode Input Source area, select the timecode source for each channel.
   - Time of Day LTC In — the LTC signal coming into the server.
   - ATC In — the embedded digital timecode in the video source.

4. In the Replace ATC Output with Timecode Remain area, select the video channels that you want the normal count-up ATC timecode to be replaced with the count-down (time-remaining) ATC timecode.
   Tip: This is useful when you want to display count-down timecode in downstream devices that can decode and display ATC timecode.

5. In the Timecode Overlay on Video Output area, select whether the timecode is displayed on the video output for each channel.
   - Off — the timecode is not shown on the video output stream.
   - On in EE and Record — the timecode is only shown when in EE mode or when the channel is recording.
   - Always On — the timecode is always shown on the video output stream.

6. In the Timecode Overlay Position And Size area, use the Left/Right and Top/Bottom sliders to position the timecode overlay on the background video source, and use the H Small/H Large and V Small/ V Large sliders to adjust the size of the timecode text.

7. Click Apply.

Channel Label Setup

You can assign a custom name to each channel transport to help identify the server it is on or what it is used for.

Labels are shown at the far right of each channel transport in Mira Explorer.

Note: The Quad Viewer Label Overlay option must be enabled for the labels to be visible on the Quad Viewer output.

To Assign Labels to Channels

Labels can be shown on the channel transport to help identify each channel.

1. Launch the Mira Config application.
   You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Labels tab.
3. Enter a new label name for each channel transport as required.
4. Click Apply.

**Count Down Display**

The Count Down output shows the program output for the Live EE, Playback, or Playlist AIR, depending how the server is configured.

*Note: When playout channels are assigned to the Control Surface, the Quad Viewer automatically shows the Count Down Display.*

- Channel label and audio meters are shown at the top of each box.
- Current timecode is shown at the bottom of each box.

**TSL Tally Setup**

The server can receive TSL messages from a downstream device to tally the channels on the server. For example, when a production switcher takes the PGM-1 source from the server on-air, the switcher sends a signal back to the server telling it that PGM-1 is on-air and should be tallied.

The tally status is shown using the color of the background of the Channel Label.

- **Gray** — the channel is not on program or preview.
- **Red** — the channel is on program.
- **Green** — the channel is on preview.
- **Amber** — the channel is being recorded by a downstream device.

*Note: TSL tally colors are set by how the protocol was implemented in the source device and may not be as listed above. Check with the device that is sending the TSL information to the server for information on how the protocol was implemented.*
To Configure the TSL Tally Input

Tally information sent to the server over ethernet using the TSL protocol is used to show red and green tallies (as well as gray and amber) on the channel labels. You will need the IP address and port of the device sending the tally information, as well as the screen mapping.

1. Launch the Mira Config application.
   You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Tally tab.

3. In the Server Address field enter the IP address of the device that is sending the TSL tally information.

4. In the Server Port field enter the port number on the device that the server is listening to.

5. In the Server Connection Type area, select the type of ethernet communication you want to use.
   • UDP — select if the tally server uses the UDP protocol.
   • TCP Server — select if the tally server is using the TCP protocol as a server.
   • TCP Client — select if the tally server is using the TCP protocol as a client.

6. In the Tally Protocol area, select the TSL protocol the tally server is using.
   • TSL UMD V5.0 — select if the tally server is using the TSL tally protocol v5.0.
   • TSL UMD V3.1 — select if the tally server is using the TSL tally protocol v3.1.

7. In the Assign Preview Tally area, select which indicator is lit when a channel transport is tallied on preview.

8. In the Assign Preview Tally Color area, select the color to use when a channel transport is tallied on preview.

9. In the Tally Index Number area, enter the tally ID that is assigned on the tally server to the input on the server.

   Tip: Refer to the device that you are receiving the tally information from for the ID that is assigned to the video input that is connected to the output of each channel on the server.

10. Click Apply.
Replay Setup

To operate the server as a replay server you must configure channels in a replay (ISO) mode, connect a Control Surface, and open a replay event.

Control Surface Connection

The Control Surface connects to the server over a standard CAT5 ethernet cable. The cable provides both communications and power (PoE - Power over Ethernet). Refer to the QuickStart poster than came with your system for cabling details.

Server Setup for Replay

You must configure the hardware channels for one of the ISO modes that meet your requirements. This configuration is based on the number of cameras you have.

To Configure the Server for Replay

Configure the server channels for the required ISO mode and assign channels to a Control Surface.

Note: You must connect the Control Surface to the server before you try to configure the server. The server will detect the Control Surface and allow you to assign channels to them.

1. Launch the Mira Config application.
   You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Channels tab.

3. Select the ISO mode for the number of cameras and playout channels that you require.

4. Click Apply.

5. Click the Control Panel tab.

6. Click Control Panel Identifier and select the Control Surface that you want to assign to channels.
   
   Tip: Each Control Surface is identified by its MAC address, which can be found on a label located on the back of the unit.

7. Click Apply.
User Setup

The user setup, or personality settings, allow you to customize the replay function to the activity or sport you are recording and your own personal preferences.

To Set the Audio Tracks for the Headphones

Assign an audio track to the left and right speakers on the headphone jack on the Control Surface, and set the volume.

1. Press **MARK + SCROLL**.
   - The *User Setup* menu opens.

2. Use the up and down arrows, or the rotary dial, to select **Control Panel Headphones Select Track Left**.
3. Use the keyboard to enter the audio track you want to use for the left speaker on the headphones output.
4. Use the up and down arrows, or the rotary dial, to select **Control Panel Headphones Select Track Right**.
5. Use the keyboard to enter the audio track you want to use for the right speaker on the headphones output.
6. Use the up and down arrows, or the rotary dial, to select **Control Panel Volume**.
7. Use the keyboard to enter the volume, as a percentage, for the headphones output.
8. Press **MARK + SCROLL** again to close the menu.

To Set the Play List Auto-fill

Clips will be automatically appended to a Play List with the same name as the clip.

If the name of the clip contains any words that are the same as a Play List name, the clip will be appended to those Play Lists. For example, if you have Play Lists named **GOAL** and **REVIEW**, any clip that has **goal** in the name is automatically appended to the **GOAL** Play List and any clip that has **review** in the name is automatically appended to the **REVIEW** Play List. If the clip have both **goal** and **review** in the name, it is appended to both Play Lists.

*Tip:* *If the Play List does not have a name, the number is used instead.*

1. Press **MARK + SCROLL**.
   - The *User Setup* menu opens.
2. Use the up and down arrows, or the rotary dial, to select **PLAYLIST Auto-Fill based on Clip Name**.

3. Press **TOGGLE (4)** to toggle this feature on or off.

4. Press **MARK + SCROLL** again to close the menu.

**To Set the Pre-roll Time**

Assign a pre-roll time to seek to the in, point of interest, and out points in a clip.

1. Press **MARK + SCROLL**.

   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **PRE-ROLL IN Time**.

3. Use the keyboard to enter the amount of time (minutes:seconds:frames) you want to use for the in-point pre-roll.

4. Use the up and down arrows, or the rotary dial, to select **PRE-ROLL POI Time**.

5. Use the keyboard to enter the amount of time (minutes:seconds:frames) you want to use for the point of interest pre-roll.

6. Use the up and down arrows, or the rotary dial, to select **PRE-ROLL OUT Time**.

7. Use the keyboard to enter the amount of time (minutes:seconds:frames) you want to use for the out-point pre-roll.

8. Press **MARK + SCROLL** again to close the menu.

**To Set the Auto Jog Feature**

Have the rotary dial automatically set to **JOG** when turned if it is not assigned to another function.

1. Press **MARK + SCROLL**.

   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **AUTO JOG for Rotary Dial**.
3. Press **TOGGLE (4)** to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Default Fast Forward and Rewind Speeds**
Set the default speed that the fast forward and rewind functions operate at.
1. Press **MARK + SCROLL**.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select **FFWD/REWIND Speed**.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Max Jog Speed**
Set the maximum speed video will move when using the rotary dial in **JOG** mode.
1. Press **MARK + SCROLL**.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select **JOG Maximum Speed**.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Max Fast Jog Speed**
Set the maximum speed video will move when using the rotary dial in **FAST JOG** mode.
1. Press **MARK + SCROLL**.
   The User Setup menu opens.
2. Use the up and down arrows, or the rotary dial, to select **FAST JOG Maximum Speed**.
3. Use the keyboard to enter the multiplier you want to use (**1X** is real-time).
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Max Cruise Speed**
Set the maximum speed video will move when using the rotary dial in **CRUISE** mode.

1. Press **MARK + SCROLL**.
   The User Setup menu opens.

   ![User Setup Menu Image]

2. Use the up and down arrows, or the rotary dial, to select **CRUISE Maximum Speed**.
3. Use the keyboard to enter the multiplier you want to use (**1X** is real-time).
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Max Fast Cruise Speed**
Set the maximum speed video will move when using the rotary dial in **FAST CRUISE** mode.

1. Press **MARK + SCROLL**.
   The User Setup menu opens.

   ![User Setup Menu Image]

2. Use the up and down arrows, or the rotary dial, to select **FAST CRUISE Maximum Speed**.
3. Use the keyboard to enter the multiplier you want to use (**1X** is real-time).
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Max T-Bar Speed (VAR 2)**
Set the maximum speed video will move when the T-bar is in the maximum speed position (top) and the **VAR 2** mode is active.

1. Press **MARK + SCROLL**.
   The User Setup menu opens.
2. Use the up and down arrows, or the rotary dial, to select T-BAR VAR-2 MAX Speed.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press MARK + SCROLL again to close the menu.

To Set the Min T-Bar Speed (VAR 2)
Set the minimum speed video will move when the T-bar is in the minimum speed position (bottom) and the VAR 2 mode is active.

Note: If the minimum speed is set below 0 (negative), then a 5 degree dead-zone is applied to the mid-point in the T-bar travel.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select T-BAR VAR-2 MAX Speed.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press MARK + SCROLL again to close the menu.

To Set the Max T-Bar Speed (VAR 3)
Set the maximum speed video will move when the T-bar is in the maximum speed position (top) and the VAR 3 mode is active.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select T-BAR VAR-3 MAX Speed.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press MARK + SCROLL again to close the menu.
To Set the Min T-Bar Speed (VAR 3)

Set the minimum speed video will move when the T-bar is in the minimum speed position (bottom) and the VAR 3 mode is active.

Note: If the minimum speed is set below 0 (negative), then a 5 degree dead-zone is applied to the mid-point in the T-bar travel.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select T-BAR VAR-3 MAX Speed.
3. Use the keyboard to enter the multiplier you want to use (1X is real-time).
4. Press MARK + SCROLL again to close the menu.

To Set the Auto-mark In-point Offset

Set the timecode that is subtracted from the point of interest (POI) timecode when saving a clip that has no in-point.

Tip: The auto-mark in-point is used when there is no in-point defined and GOTO IN is pressed.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select AUTO-MARK IN.
3. Use the keyboard to enter the amount of time (minutes:seconds:frames) you want to offset from the POI time.
4. Press MARK + SCROLL again to close the menu.

To Set the Auto-mark Out-point Offset

Set the timecode that is added to the point of interest (POI) timecode when saving a clip that have no out-point.

Tip: The auto-mark out-point is used when there is no out-point defined and GOTO OUT is pressed.

1. Press MARK + SCROLL.
   The User Setup menu opens.
2. Use the up and down arrows, or the rotary dial, to select **AUTO-MARK OUT**.
3. Use the keyboard to enter the amount of time (minutes:seconds:frames) you want to offset from the POI time.
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Action of Camera Softkeys in CP Mode**

Set what happens when a camera softkey is press when **CLIP PLAY** (CP) playback mode is active.

1. Press **MARK + SCROLL**.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select **Camera Softkey Change on CP Mode**.
3. Select what you want to happen when you press a camera softkey when in CP mode.
   - **Cue to IN & Play** — seek to the in-point of the clip and then play the clip.
   - **Change Angle Only** — switch to the selected camera angle at the current timecode. The clip will continue to play if it was playing before.
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Transition Type for Two Replay Channels**

Select the type of transition that is applied when you press **TAKE** in Playlist mode (**PL**) and have two replay channels. The transition occurs between the two channels.

1. Press **MARK + SCROLL**.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select **2-Replay Channel TRANSITION**.
3. Select the type of transition you want to use to transition between the two channels.
   - **MIX** — perform a dissolve between the two channels.
• **CUT** — perform an immediate switch between the two channels.

4. Press **MARK + SCROLL** again to close the menu.

**To Set the Duration of a Mix Transition**
Set the duration of the mix transition between the two replay channels.

1. Press **MARK + SCROLL**.
   
   The User Setup menu opens.

   ![User Setup Menu](image)

2. Use the up and down arrows, or the rotary dial, to select **MIX TRANSITION Duration**.
3. Use the keyboard to enter the amount of time (seconds:frames) you want the transition to take.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Whether Gang Mode is Selected for Live EE Record**
Set whether **GANG** is automatically selected for **Output Control** when the **LIVE EE** record button is pressed.

1. Press **MARK + SCROLL**.
   
   The User Setup menu opens.

   ![User Setup Menu](image)

2. Use the up and down arrows, or the rotary dial, to select **AUTO GANG for LIVE EE**.
3. Press **TOGGLE (4)** to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Whether Gang Mode is Deselected if a Playout Channel is Selected**
Set whether **GANG** is automatically deselected for **Output Control** when any of the playout channels (P1, P2, P3, P4) are selected.

1. Press **MARK + SCROLL**.
   
   The User Setup menu opens.
2. Use the up and down arrows, or the rotary dial, to select **GANG Disable when P1/P2/P3/P4 is pressed**.

3. Press **TOGGLE (4)** to toggle this feature on or off.

4. Press **MARK + SCROLL** again to close the menu.

---

**To Set Whether Preferred Camera Angles are Used for Live EE Record**

Set whether the preferred camera angle for each playout channel is selected when • is pressed.

1. Press **MARK + SCROLL**.

   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **LIVE-EE Auto-Select Preferred CAMs**.

3. Press **TOGGLE (4)** to toggle this feature on or off.

4. Press **MARK + SCROLL** again to close the menu.

---

**To Set the Preferred Camera Angles**

Set the preferred camera angle for each playout channel.

1. Press **MARK + SCROLL**.

   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **P1 Preferred CAM**.

3. Select the camera you want to assign to the playout channel.

4. Repeat these steps for the remaining playout channels.

5. Press **MARK + SCROLL** again to close the menu.

---

**To Set the Preferred Play List**

Set the preferred Play List for each playout channel when a Replay Event is launched.

1. Press **MARK + SCROLL**.
The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **P1 Preferred Playlist**.
3. Use the keyboard to enter the Play List number (1-99) you want to assign to the playout channel.
4. Repeat these steps for the remaining playout channels.
5. Press **MARK + SCROLL** again to close the menu.

**To Set Whether a Clip is Automatically Loaded in CP Mode**

Set whether a new clip is automatically loaded when the selection highlight is moved to the next clip when **CLIP PLAY** mode is active. When this setting is **OFF** you must select the clip and press **LOAD** to manually load the clip.

1. Press **MARK + SCROLL**.
   
   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **AUTO LOAD clip upon cursor move in CLIP PLAY mode**.
3. Press **TOGGLE** (4) to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Whether the Out-point of a Clip is Used in CP Mode**

Set whether a clip stops playing when it reaches the out-point in **CLIP PLAY** mode. When this setting is **OFF** the clip will continue to play through the out-point.

1. Press **MARK + SCROLL**.
   
   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **Obey clip OUT point in CP Mode**.
3. Press **TOGGLE** (4) to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Whether Play List uses PGM/PVW**
Set whether a Play List will always play out of two channels (PGM/PVW) when on-air in **PLAY LISY** mode. When this setting is **OFF** you can choose to play out on two channels (PGM/PVW) or a single channel.

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.

   ![User Setup Menu]

2. Use the up and down arrows, or the rotary dial, to select **ALWAYS use PVW/PGM pair in PLAY LIST AIR**.
3. Press **TOGGLE** (4) to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Whether a Mark Point is Saved to the Clip Register**
Set whether a mark point is added to the Play List and saved in the Clip Register when **APPEND** is pressed. When this setting is **OFF** the mark point is added to the Play List but not saved to the Clip Register.

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.

   ![User Setup Menu]

2. Use the up and down arrows, or the rotary dial, to select **Vue Marks AUTO Save to Clip Register when Append**.
3. Press **TOGGLE** (4) to toggle this feature on or off.
4. Press **MARK + SCROLL** again to close the menu.

**To Set the Amount Inactive Lists are Dimmed**
Set the amount the Clip Register or Play List are dimmed when not active. This helps to quickly focus on the list that is currently active.

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.
2. Use the up and down arrows, or the rotary dial, to select **Dim for inactive clips and lists**.
3. Use the keyboard to enter the amount (0-100%) you want to dim a list area when it is not active. Select 0 for full brightness with no dimming.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Control Surface Brightness**
Set the brightness of the buttons and LEDs on the Control Surface.

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **Panel Brightness**.
3. Use the keyboard to enter the amount of brightness (5-100%) you want to apply to the buttons and LEDs on the Control Surface.
4. Press **MARK + SCROLL** again to close the menu.

**To Set Control Surface Contrast**
Set the contrast of the buttons on the Control Surface.

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.

2. Use the up and down arrows, or the rotary dial, to select **Light contrast**.
3. Use the keyboard to enter the amount of contrast (0-900) you want to apply to the buttons on the Control Surface.
4. Press **MARK + SCROLL** again to close the menu.
To Set Playout Channel Color
Set the color that is applied to the border of each playout channel and the corresponding OUTPUT CONTROL button on the Control Surface.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select Replay P1 Channel Color.
3. Select the color you want to assign to the border of the playout channel.
4. Repeat for each playout channel in your system.
5. Press MARK + SCROLL again to close the menu.

To Set the Saturation of the Playout Channel Borders
Set the amount of saturation applied to the borders of the playout channels.

1. Press MARK + SCROLL.
   The User Setup menu opens.

2. Use the up and down arrows, or the rotary dial, to select Desaturate P1/P2/P3/P4 monitor border.
3. Use the keyboard to enter the amount of saturation (0-100%) you want to apply to the borders of the playout channels.
4. Press MARK + SCROLL again to close the menu.

To Set the Source of the Name that is Applied to New Clips
Set the source of the name that is applied to all camera angles when SAVE is pressed.

1. Press MARK + SCROLL.
   The User Setup menu opens.
2. Use the up and down arrows, or the rotary dial, to select **Title new clips**.
3. Select the source of the title you want to apply to the camera angles and clip name.
   - **IN Timecode** — in-point timecode is used as the name.
   - **OUT Timecode** — out-point timecode is used as the name.
   - none — no default name is applied.
4. Press **MARK + SCROLL** again to close the menu.

### To Set the Initial Clip Name Options
Set the name prefixes you would like to be able to assign to new clips from the Control Surface. When you press the corresponding softkey the name is applied to the clip. An additional part to the name can be applied to the name with the use of the remaining softkeys.

**Tip:** You can also set the initial clip names from the **Replay Event Setup** menu (Press **MARK + SCROLL > Modify Labels (7)**).  

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.

   ![User Setup Menu](image)

2. Use the up and down arrows, or the rotary dial, to select **Initial name 1**.
3. Use the keyboard to enter the default name you would like to assign to the 8 softkey (max 25 characters).
4. Use the up and down arrows, or the rotary dial, to select **Initial name 2**.
5. Use the keyboard to enter the default name you would like to assign to the 9 softkey (max 25 characters).
6. Use the up and down arrows, or the rotary dial, to select **Initial name 3**.
7. Use the keyboard to enter the default name you would like to assign to the 10 softkey (max 25 characters).

   **Note:** The 10 softkey does not have the option to add an additional part to the name.

8. Press **MARK + SCROLL** again to close the menu.

### To Set the Clip Name Options
Set the name you would like to be able to assign to new clips from the Control Surface. When you press the corresponding softkey the name is applied to the clip after the prefix you added with the 8 or 9 softkey.

**Tip:** You can also set the clip names from the **Replay Event Setup** menu (Press **MARK + SCROLL > Modify Labels (7)**).

1. Press **MARK + SCROLL**.
   The **User Setup** menu opens.
2. Use the up and down arrows, or the rotary dial, to select **Name 1 Row 1**.

3. Use the keyboard to enter the default name you would like to assign to the 1 softkey (max 25 characters) on the bottom row.

   **Tip:** Assign the name to the clip by pressing the softkey on the Control Surface.

4. Continue to assign names to the first row of buttons.

5. Use the up and down arrows, or the rotary dial, to select **Name 1 Row 2**.

6. Use the keyboard to enter the default name you would like to assign to the 1 softkey (max 25 characters) on the top row.

   **Tip:** Assign the name to the clip by pressing **SHIFT** and the softkey on the Control Surface.

7. Continue to assign names to the second row of buttons.

8. Press **MARK + SCROLL** again to close the menu.

### User Setup Files

The user setup files contain all the user settings and allow you to quickly switch the feel of the replay work-flow to better match the preferences of individual operators and the requirements of the event being covered.

#### To Save a User Setup File

User Setup files can be stored either to the hard drive or a USB drive installed into the USB port on the Control Surface.

1. Press **MARK + SCROLL > User Setup Files (5)**.

2. Select the drive you want to store the file to.

   **Note:** If you want to store the file to a USB drive, you must install the USB drive into the USB port on the front of the Control Surface.

   - **Hard Drive** — selected by default (press **H: Drive (7)** from USB selection)
   - **USB** — press **Control Surface USB (7)**.

3. In the **ENTRY** field, enter the name you want to give the user setup file and press **SAVE New File (2)**.

   **Tip:** If you want to overwrite an existing file, select the file and press **SHIFT + OVERWRITE File (2)**.

4. Press **EXIT (10)**.

#### To Load a User Setup File

User Setup files can be loaded either from the hard drive or a USB drive installed into the USB port on the Control Surface.

1. Press **MARK + SCROLL > User Setup Files (5)**.

2. Select the drive where the file is stored.

   **Note:** If the file is stored on a USB drive, you must install the USB drive into the USB port on the front of the Control Surface.

   - **Hard Drive** — selected by default (press **H: Drive (7)** from USB selection)
• **USB** — press Control Surface USB (7).

3. Select the user setup file that you want to load and press **LOAD File (1)**.

   **Tip:** To rename an existing file on the selected drive select the user setup file you want to rename, enter a new name in the ENTRY field, and press **RE-NAME File (3)**.

4. Press **EXIT (10)**.

**To Name a Camera Input**

Set the name that appears on the menus for the camera input.

1. Press **MARK + SCROLL > Modify Labels (7) > Camera Labels (7)**.
2. Use the up and down arrows, or the rotary dial, to select the camera you want to change the name of.
3. Use the keyboard to enter the new name for the camera input.
4. Press **MARK + SCROLL** again to close the menu.
**Import**

The **Mira Import** file import utility converts all imported media files to the current video output format that the server is operating in.

For example, if the server is currently operating in the 1080i 59.94Hz video format, then all imported media files are converted to 1080i 59.94Hz video format. Media files are converted even if they are in a different video format.

**Supported Media Files for Hardware Import**

*Note: Some file formats require a third-party codec to be installed on the server.*

*Note: Ancillary data is preserved from the import of MXF files in systems with JPEG 2000 or AVC-Intra native recording formats.*

<table>
<thead>
<tr>
<th>File Type</th>
<th>Codec</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV</td>
<td>(DV25) DVCPRO</td>
<td>none needed</td>
</tr>
<tr>
<td>DV</td>
<td>(DV50) DVCPRO 50</td>
<td>Calibrated(Q) DV50 Decode&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>DV</td>
<td>(DV50) DVCPRO 50</td>
<td>Calibrated(Q) DV100 Decode + MXF Import Bundle #2&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>MOV</td>
<td>(DV25) DVCPRO</td>
<td>none needed</td>
</tr>
<tr>
<td>MOV</td>
<td>(DV50) DVCPRO 50</td>
<td>Calibrated(Q) DV50 Decode&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>MOV</td>
<td>(DV100) DVCPRO HD</td>
<td>Calibrated(Q) QuickTime&lt;sup&gt;®&lt;/sup&gt; DVCPRO HD Playback components&lt;sup&gt;6&lt;/sup&gt;</td>
</tr>
<tr>
<td>Animation</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>H.264</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>JPEG</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>JPEG 2000</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>MPEG-E Video</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>NONE (No Compression)</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>ProRes</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>PNG</td>
<td></td>
<td>none needed</td>
</tr>
<tr>
<td>Apple&lt;sup&gt;®&lt;/sup&gt; XDCam-HD</td>
<td></td>
<td>Calibrated(Q) XD Decode&lt;sup&gt;3&lt;/sup&gt;</td>
</tr>
<tr>
<td>Avid&lt;sup&gt;®&lt;/sup&gt; DNxHD</td>
<td></td>
<td>Avid&lt;sup&gt;®&lt;/sup&gt; DNxHD&lt;sup&gt;7&lt;/sup&gt;</td>
</tr>
<tr>
<td>Apple&lt;sup&gt;®&lt;/sup&gt; XDCam-HD</td>
<td></td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1&lt;sup&gt;4&lt;/sup&gt;</td>
</tr>
<tr>
<td>XDCam EX</td>
<td></td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1&lt;sup&gt;4&lt;/sup&gt;</td>
</tr>
<tr>
<td>HDV</td>
<td></td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1&lt;sup&gt;4&lt;/sup&gt;</td>
</tr>
<tr>
<td>(DV50) DVCPRO 50</td>
<td></td>
<td>Calibrated(Q) DV100 Decode + MXF Import Bundle #2&lt;sup&gt;5&lt;/sup&gt;</td>
</tr>
<tr>
<td>File Type</td>
<td>Codec</td>
<td>Plug-in</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>MXF</td>
<td>Apple® XDCam-HD</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>XDCam EX</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>HDV</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>(DV25) DVCPRO</td>
<td>Calibrated(Q) MXF Import</td>
</tr>
<tr>
<td></td>
<td>(DV50) DVCPRO 50</td>
<td>Calibrated(Q) DV50 Decode</td>
</tr>
<tr>
<td></td>
<td>(DV100) DVCPRO HD</td>
<td>Calibrated(Q) DV100 Decode + MXF Import Bundle #2</td>
</tr>
<tr>
<td></td>
<td>Apple® XDCam-HD</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>XDCam EX</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>HDV</td>
<td>Calibrated(Q) XD Decode + MXF Import Bundle #1</td>
</tr>
<tr>
<td></td>
<td>(DV50) DVCPRO 50</td>
<td>Calibrated(Q) DV100 Decode + MXF Import Bundle #2</td>
</tr>
</tbody>
</table>

| P2*       | (DV25) DVCPRO  | Calibrated(Q) MXF Import                      |
|           | (DV50) DVCPRO 50| Calibrated(Q) MXF Import                      |
|           | (DV100) DVCPRO HD| Calibrated(Q) DV100 Decode + MXF Import Bundle #2|
|           | Apple® XDCam-HD| Calibrated(Q) XD Decode + MXF Import Bundle #1|
|           | XDCam EX       | Calibrated(Q) XD Decode + MXF Import Bundle #1|
|           | HDV            | Calibrated(Q) XD Decode + MXF Import Bundle #1|
|           | (DV50) DVCPRO 50| Calibrated(Q) DV100 Decode + MXF Import Bundle #2|

• When importing a P2 file, select the .mxf file in the P2 CONTENTS/VIDEO directory.
• ¹ This plugin from Calibrated Software enables Mira Express to read MXF files. Additional codec(s) may be required to decode the video essence within some MXF files. MXFImport_Win.asp
• ² This codec from Calibrated Software enables import of DVCPRO 50 essence within MOV or DV files. QDV50.asp
  Tip: In combination with the Calibrated(Q) MXF Import component, this DV50 codec enables import of DVCPRO 50 essence within MXF files [MXFImport_Win.asp].
• ³ This codec from Calibrated Software enables import of XDCam-HD essence within MOV files. QXD.asp
• ⁴ This codec from Calibrated Software enables import of XDCam-HD essence within MXF and P2 files. WindowsBundleStore.asp (select Bundle#1)
• ⁵ This codec from Calibrated Software enables import of DV100 essence within MXF and P2 files. WindowsBundleStore.asp (select Bundle#2)
• ⁶ This codec from Calibrated Software enables import of DVCPRO HD essence within MOV files. QDVCPROHDDownload.asp
  Tip: In combination with Calibrated(Q) MXF Import component, this codec enables import of DVCPRO HD essence within MXF files.
• ⁷ This codec from Avid® enables import of DNxHD essence within MOV files. AvidCodecsLESetup.zip

Supported Import Transcoding

The Software Transcoder in Mira Import uses FFmpeg™ for the decoding operation.
In the table below, the legend column identifies which elements of the media file are supported.
• E — Encoding supported
• D — Decoding supported
- V/A — Video codec (V) / Audio Codec (A)
- I — Intra frame-only codec
- L — Lossy compression
- S — Lossless compression

### Video+Audio and Video Only Media Files

<table>
<thead>
<tr>
<th>Codec</th>
<th>Codec Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>012v</td>
<td>Uncompressed 4:2:2 10-bit</td>
</tr>
<tr>
<td>4xm</td>
<td>4X Technologies Movie</td>
</tr>
<tr>
<td>8bps</td>
<td>QuickTime® 8BPS video</td>
</tr>
<tr>
<td>aasc</td>
<td>Autodesk® RLE</td>
</tr>
<tr>
<td>aic</td>
<td>Apple® Intermediate Codec</td>
</tr>
<tr>
<td>alias_pix</td>
<td>Alias/Wavefront PIX image</td>
</tr>
<tr>
<td>amv</td>
<td>AMV Video</td>
</tr>
<tr>
<td>anm</td>
<td>EA® DeluxePaint</td>
</tr>
<tr>
<td>ansi</td>
<td>ASCII/ANSI art</td>
</tr>
<tr>
<td>apng</td>
<td>APNG (Animated Portable Network Graphics) image</td>
</tr>
<tr>
<td>asv1</td>
<td>ASUS V1</td>
</tr>
<tr>
<td>asv2</td>
<td>ASUS V2</td>
</tr>
<tr>
<td>aura</td>
<td>Auravision AURA</td>
</tr>
<tr>
<td>aura2</td>
<td>Auravision Aura 2</td>
</tr>
<tr>
<td>avrn</td>
<td>Avid® AVI Codec</td>
</tr>
<tr>
<td>avrp</td>
<td>Avid® 1:1 10-bit RGB Packer</td>
</tr>
<tr>
<td>avs</td>
<td>AVS (Audio Video Standard) video</td>
</tr>
<tr>
<td>avui</td>
<td>Avid® Meridien Uncompressed</td>
</tr>
<tr>
<td>ayuv</td>
<td>Uncompressed packed MS 4:4:4:4</td>
</tr>
<tr>
<td>bethsoftvid</td>
<td>Bethesda® VID video</td>
</tr>
<tr>
<td>bfi</td>
<td>Brute Force &amp; Ignorance</td>
</tr>
<tr>
<td>binkvideo</td>
<td>Bink® video</td>
</tr>
<tr>
<td>bintext</td>
<td>Binary text</td>
</tr>
<tr>
<td>bmp</td>
<td>BMP (Windows® and OS/2 bitmap)</td>
</tr>
<tr>
<td>bmv_video</td>
<td>Discworld® II BMV video</td>
</tr>
<tr>
<td>brender_pix</td>
<td>BRender PIX image</td>
</tr>
<tr>
<td>c93</td>
<td>Interplay® C93</td>
</tr>
<tr>
<td>cavs</td>
<td>Chinese AVS (Audio Video Standard) (AVS1-P2, JiZhun profile)</td>
</tr>
<tr>
<td>cdgraphics</td>
<td>CD Graphics video</td>
</tr>
<tr>
<td>Codec</td>
<td>Codec Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>cdxl</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>cfhd</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>cinepak</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>cljr</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>clic</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>cmv</td>
</tr>
<tr>
<td>.DV...</td>
<td>cplia</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>cscd</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>cyuv</td>
</tr>
<tr>
<td>.DVILS</td>
<td>dds</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>dfa</td>
</tr>
<tr>
<td>EDV.LS</td>
<td>dirac</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>dnxhd</td>
</tr>
<tr>
<td>EDV.I.S</td>
<td>dpx</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>dsicinvideo</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>dvvideo</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>dxa</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>dxtory</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>dxv</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>escape124</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>escape130</td>
</tr>
<tr>
<td>.DVILS</td>
<td>exr</td>
</tr>
<tr>
<td>EDV..S</td>
<td>ffv1</td>
</tr>
<tr>
<td>EDV.I.S</td>
<td>ffvhuff</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>fic</td>
</tr>
<tr>
<td>EDV..S</td>
<td>flashsv</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>flashsv2</td>
</tr>
<tr>
<td>.DV..S</td>
<td>flic</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>f1v</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>fraps</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>frwu</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>g2m</td>
</tr>
<tr>
<td>EDV..S</td>
<td>gif</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>h261</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>h263i</td>
</tr>
<tr>
<td>EDV.LS</td>
<td>h264</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>hap</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>hevc</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>hnm4video</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>hq_hqa</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>hqx</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>huffyuv</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>idcin</td>
</tr>
<tr>
<td>.DVI..</td>
<td>idf</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>iff_ilbm</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>indeo2</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>indeo3</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>indeo4</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>indeo5</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>interplayvideo</td>
</tr>
<tr>
<td>EDVILS</td>
<td>jpeg2000</td>
</tr>
<tr>
<td>EDVILS</td>
<td>jpegls</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>jv</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>kgv1</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>kmvc</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>lagarith</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>loco</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>m101</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mad</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>magicyuv</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>mdec</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mimic</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>mjpeg</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>mjpegb</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mmvideo</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>motionpixels</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>mpeg1video</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>mpeg2video</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>mpeg4</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>msa1</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>msmpeg4v1</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>msmpeg4v2</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>msmpeg4v3</td>
</tr>
<tr>
<td>.DV.S</td>
<td>msrle</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mss1</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>mss2</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>msvideo1</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>mszh</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mts2</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>mvc1</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>mvc2</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>mxpeg</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>nuv</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>paf_video</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>pam</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>pbm</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>pcx</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>pgm</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>pgmyuv</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>pictor</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>png</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>ppm</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>prores</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>ptx</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>qdraw</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>qpeg</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>EDV..S</td>
<td>qtrle</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>r10k</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>r210</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>rawvideo</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>rl2</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>roq</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>rpza</td>
</tr>
<tr>
<td>.DV..S</td>
<td>rscq</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>rv10</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>rv20</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>rv30</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>rv40</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>sanm</td>
</tr>
<tr>
<td>.DV..S</td>
<td>screenpresso</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>sgi</td>
</tr>
<tr>
<td>.DV..S</td>
<td>sgirle</td>
</tr>
<tr>
<td>.DV..S</td>
<td>sheervideo</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>smackvideo</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>smc</td>
</tr>
<tr>
<td>.DV..</td>
<td>smvjpeg</td>
</tr>
<tr>
<td>EDV.LS</td>
<td>snow</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>sp5x</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>sunrast</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>svq1</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>svq3</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>targa</td>
</tr>
<tr>
<td>.DVI..</td>
<td>targa_y216</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>tdsc</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>tgq</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>tgv</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>theora</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>thp</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>tier.texeseqvideo</td>
</tr>
<tr>
<td><strong>Codec</strong></td>
<td><strong>Codec Description</strong></td>
</tr>
<tr>
<td>----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIFF image</td>
</tr>
<tr>
<td>TMV</td>
<td>8088flex TMV</td>
</tr>
<tr>
<td>TQI</td>
<td>Electronic Arts TQI video (decoders: eatqi)</td>
</tr>
<tr>
<td>TrueMotion 1.0</td>
<td>Google® (On2/Duck) TrueMotion 1.0</td>
</tr>
<tr>
<td>TrueMotion 2.0</td>
<td>Google® (On2/Duck) TrueMotion 2.0</td>
</tr>
<tr>
<td>TrueMotion 2.0 Real Time</td>
<td>Google® (On2/Duck) TrueMotion 2.0 Real Time</td>
</tr>
<tr>
<td>TechSmith® Screen Capture Codec (decoders: Camtasia®)</td>
<td>TechSmith® Screen Capture Codec (decoders: Camtasia®)</td>
</tr>
<tr>
<td>TechSmith® Screen Codec 2</td>
<td>TechSmith® Screen Codec 2</td>
</tr>
<tr>
<td>RenderWare TXD (TeXture Dictionary) image</td>
<td>RenderWare TXD (TeXture Dictionary) image</td>
</tr>
<tr>
<td>Ut Video</td>
<td>Ut Video</td>
</tr>
<tr>
<td>Uncompressed 4:2:2 10-bit</td>
<td>Uncompressed 4:2:2 10-bit</td>
</tr>
<tr>
<td>Uncompressed packed 4:4:4</td>
<td>Uncompressed packed 4:4:4</td>
</tr>
<tr>
<td>Uncompressed packed QT 4:4:4</td>
<td>Uncompressed packed QT 4:4:4</td>
</tr>
<tr>
<td>Uncompressed 4:4:4 10-bit</td>
<td>Uncompressed 4:4:4 10-bit</td>
</tr>
<tr>
<td>Beam Software VB</td>
<td>Beam Software VB</td>
</tr>
<tr>
<td>VBLE Lossless Codec</td>
<td>VBLE Lossless Codec</td>
</tr>
<tr>
<td>SMPTE® VC-1</td>
<td>SMPTE® VC-1</td>
</tr>
<tr>
<td>Windows Media® Video 9 Image v2</td>
<td>Windows Media® Video 9 Image v2</td>
</tr>
<tr>
<td>ATI® VCR1</td>
<td>ATI® VCR1</td>
</tr>
<tr>
<td>Miro VideoXL (decoders: xl)</td>
<td>Miro VideoXL (decoders: xl)</td>
</tr>
<tr>
<td>Sierra Entertainment VMD (Video and Music Data) video</td>
<td>Sierra Entertainment VMD (Video and Music Data) video</td>
</tr>
<tr>
<td>VMware® Screen Codec / VMware® Video</td>
<td>VMware® Screen Codec / VMware® Video</td>
</tr>
<tr>
<td>On2 VP3</td>
<td>On2 VP3</td>
</tr>
<tr>
<td>On2 VP5</td>
<td>On2 VP5</td>
</tr>
<tr>
<td>On2 VP6</td>
<td>On2 VP6</td>
</tr>
<tr>
<td>On2 VP6 (Flash® version, with alpha channel)</td>
<td>On2 VP6 (Flash® version, with alpha channel)</td>
</tr>
<tr>
<td>On2 VP6 (Flash® version)</td>
<td>On2 VP6 (Flash® version)</td>
</tr>
<tr>
<td>On2 VP7</td>
<td>On2 VP7</td>
</tr>
<tr>
<td>On2 VP8</td>
<td>On2 VP8</td>
</tr>
<tr>
<td>Google® VP9</td>
<td>Google® VP9</td>
</tr>
<tr>
<td>Google® WebP</td>
<td>Google® WebP</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>wmv1</td>
</tr>
<tr>
<td>EDV.L.</td>
<td>wmv2</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>wmv3</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>wmv3image</td>
</tr>
<tr>
<td>.DVIL.</td>
<td>wvn1</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>ws_vqa</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>xan_wc3</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>xan_wc4</td>
</tr>
<tr>
<td>.DVI.</td>
<td>xbin</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>xbm</td>
</tr>
<tr>
<td>EDVIL.</td>
<td>xface</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>xwd</td>
</tr>
<tr>
<td>EDVI.</td>
<td>y41p</td>
</tr>
<tr>
<td>.DVI.S</td>
<td>ylc</td>
</tr>
<tr>
<td>.DV.L.</td>
<td>yop</td>
</tr>
<tr>
<td>EDVI.</td>
<td>yuv4</td>
</tr>
<tr>
<td>.DV.S</td>
<td>zerocodec</td>
</tr>
<tr>
<td>EDVI.S</td>
<td>zlib</td>
</tr>
<tr>
<td>EDV.S</td>
<td>zmbv</td>
</tr>
</tbody>
</table>

**Audio-Only Media Files**

<table>
<thead>
<tr>
<th>Legend</th>
<th>Codec</th>
<th>Codec Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DA.L.</td>
<td>8svx_exp</td>
<td>Electronic Arts 8SVX exponential</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>8svx_fib</td>
<td>Electronic Arts 8SVX fibonacci</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>aac</td>
<td>AAC (Advanced Audio Coding) (decoders: aac aac_fixed)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>aac_latm</td>
<td>AAC LATM (Advanced Audio Coding LATM syntax)</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>ac3</td>
<td>ATSC A/52A (AC-3) (decoders: ac3 ac3_fixed) (encoders: ac3 ac3_fixed)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_4xm</td>
<td>ADPCM 4X Movie</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_adx</td>
<td>SEGA® CRI ADX ADPCM</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_afc</td>
<td>ADPCM Nintendo® Gamecube® AFC</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_aica</td>
<td>ADPCM Yamaha® AICA</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ct</td>
<td>ADPCM Creative Technology</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_dtk</td>
<td>ADPCM Nintendo® Gamecube® DTK</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
<td>Codec Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea</td>
<td>ADPCM Electronic Arts</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea_maxis_xa</td>
<td>ADPCM Electronic Arts Maxis® CDROM XA</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea_r1</td>
<td>ADPCM Electronic Arts R1</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea_r2</td>
<td>ADPCM Electronic Arts R2</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea_r3</td>
<td>ADPCM Electronic Arts R3</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ea_xas</td>
<td>ADPCM Electronic Arts XAS</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_g722</td>
<td>G.722 ADPCM (decoders: g722) (encoders: g722)</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_g726</td>
<td>G.726 ADPCM (decoders: g726) (encoders: g726)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_g726le</td>
<td>G.726 ADPCM little-endian (decoders: g726le)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_amv</td>
<td>ADPCM IMA AMV</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_apc</td>
<td>ADPCM IMA CRYO APC</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_dat4</td>
<td>ADPCM IMA Eurocom DAT4</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_dk3</td>
<td>ADPCM IMA On2/Duck DK3</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_dk4</td>
<td>ADPCM IMA On2/Duck DK4</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_ea_eacs</td>
<td>ADPCM IMA Electronic Arts EACS</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_ea_sead</td>
<td>ADPCM IMA Electronic Arts SEAD</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_iss</td>
<td>ADPCM IMA Funcom® ISS</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_oki</td>
<td>ADPCM IMA Dialogic (OKI®)</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_ima_qt</td>
<td>ADPCM IMA QuickTime®</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_rad</td>
<td>ADPCM IMA Radical</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_smjpeg</td>
<td>ADPCM IMA Loki SDL MJPEG</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_ima_wav</td>
<td>ADPCM IMA WAV</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_ima_ws</td>
<td>ADPCM IMA Westwood Studios</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_ms</td>
<td>ADPCM Microsoft®</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_mtaf</td>
<td>ADPCM MTAF</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_psx</td>
<td>ADPCM Playstation®</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_sbpro_2</td>
<td>ADPCM Sound Blaster® Pro 2-bit</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_sbpro_3</td>
<td>ADPCM Sound Blaster® Pro 2.6-bit</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_sbpro_4</td>
<td>ADPCM Sound Blaster® Pro 4-bit</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>adpcm_swf</td>
<td>ADPCM Shockwave® Flash®</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_thp</td>
<td>ADPCM Nintendo® THP</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_thp_le</td>
<td>ADPCM Nintendo® THP (Little-Endian)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_vima</td>
<td>LucasArts® VIMA audio</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>adpcm_xa</td>
<td>ADPCM CDROM XA</td>
</tr>
<tr>
<td>Codec</td>
<td>Codec Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>adpcm_yamaha</td>
<td>ADPCM Yamaha®</td>
<td></td>
</tr>
<tr>
<td>alac</td>
<td>ALAC (Apple® Lossless Audio Codec)</td>
<td></td>
</tr>
<tr>
<td>amr_nb</td>
<td>AMR-NB (Adaptive Multi-Rate NarrowBand) (decoders: amrnb)</td>
<td></td>
</tr>
<tr>
<td>amr_wb</td>
<td>AMR-WB (Adaptive Multi-Rate WideBand) (decoders: amrwb)</td>
<td></td>
</tr>
<tr>
<td>ape</td>
<td>Monkey’s Audio</td>
<td></td>
</tr>
<tr>
<td>atrac1</td>
<td>Sony® ATRAC1 (Adaptive TRansform Acoustic Coding)</td>
<td></td>
</tr>
<tr>
<td>atrac3</td>
<td>Sony® ATRAC3 (Adaptive TRansform Acoustic Coding 3)</td>
<td></td>
</tr>
<tr>
<td>atrac3p</td>
<td>Sony® ATRAC3+ (Adaptive TRansform Acoustic Coding 3+)  (decoders: atrac3plus)</td>
<td></td>
</tr>
<tr>
<td>avc</td>
<td>On2 Audio for Video Codec (decoders: on2avc)</td>
<td></td>
</tr>
<tr>
<td>binkaudio_dct</td>
<td>Bink® Audio (DCT)</td>
<td></td>
</tr>
<tr>
<td>binkaudio_rdft</td>
<td>Bink® Audio (RDFT)</td>
<td></td>
</tr>
<tr>
<td>bmv_audio</td>
<td>Discworld® II BMV audio</td>
<td></td>
</tr>
<tr>
<td>comfortnoise</td>
<td>RFC 3389 Comfort Noise</td>
<td></td>
</tr>
<tr>
<td>cook</td>
<td>Cook / Cooker / Gecko (RealAudio® G2)</td>
<td></td>
</tr>
<tr>
<td>dsd_lsbf</td>
<td>DSD (Direct Stream Digital), least significant bit first</td>
<td></td>
</tr>
<tr>
<td>dsd_lsbf_planar</td>
<td>DSD (Direct Stream Digital), least significant bit first, planar</td>
<td></td>
</tr>
<tr>
<td>dsd_msbf</td>
<td>DSD (Direct Stream Digital), most significant bit first</td>
<td></td>
</tr>
<tr>
<td>dsd_msbf_planar</td>
<td>DSD (Direct Stream Digital), most significant bit first, planar</td>
<td></td>
</tr>
<tr>
<td>dsicinaudio</td>
<td>Delphine Software International CIN audio</td>
<td></td>
</tr>
<tr>
<td>dss_sp</td>
<td>Digital Speech Standard - Standard Play mode (DSS SP)</td>
<td></td>
</tr>
<tr>
<td>dst</td>
<td>DST (Direct Stream Transfer)</td>
<td></td>
</tr>
<tr>
<td>dts</td>
<td>DCA (DTS Coherent Acoustics) (decoders: dca) (encoders: dca)</td>
<td></td>
</tr>
<tr>
<td>dvaudio</td>
<td>DV audio</td>
<td></td>
</tr>
<tr>
<td>eac3</td>
<td>ATSC A/52B (AC-3, E-AC-3)</td>
<td></td>
</tr>
<tr>
<td>evrc</td>
<td>EVRC (Enhanced Variable Rate Codec)</td>
<td></td>
</tr>
<tr>
<td>flac</td>
<td>FLAC (Free Lossless Audio Codec)</td>
<td></td>
</tr>
<tr>
<td>g723_1</td>
<td>G.723.1</td>
<td></td>
</tr>
<tr>
<td>g729</td>
<td>G.729</td>
<td></td>
</tr>
<tr>
<td>gsm</td>
<td>GSM</td>
<td></td>
</tr>
<tr>
<td>gsm_ms</td>
<td>GSM Microsoft® variant</td>
<td></td>
</tr>
<tr>
<td>iac</td>
<td>IAC (Indeo Audio Coder)</td>
<td></td>
</tr>
<tr>
<td>imc</td>
<td>IMC (Intel® Music Coder)</td>
<td></td>
</tr>
<tr>
<td>interplay_dpcm</td>
<td>DPCM Interplay</td>
<td></td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
<td>Codec Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>interplayacm</td>
<td>Interplay® ACM</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mace3</td>
<td>MACE (Macintosh® Audio Compression/Expansion) 3:1</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mace6</td>
<td>MACE (Macintosh® Audio Compression/Expansion) 6:1</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>metasound</td>
<td>Voxware® MetaSound</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>mlp</td>
<td>MLP (Meridian Audio Lossless Packing)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mp1</td>
<td>MP1 (MPEG audio layer 1) (decoders: mp1 mp1float)</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>mp2</td>
<td>MP2 (MPEG audio layer 2) (decoders: mp2 mp2float) (encoders: mp2 mp2fixed)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mp3</td>
<td>MP3 (MPEG audio layer 3) (decoders: mp3 mp3float)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mp3adu</td>
<td>ADU (Application Data Unit) MP3 (MPEG audio layer 3) (decoders: mp3adu mp3adufloat)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>mp3on4</td>
<td>MP3onMP4 (decoders: mp3on4 mp3on4float)</td>
</tr>
<tr>
<td>.DA.S</td>
<td>mp4als</td>
<td>MPEG-4 Audio Lossless Coding (ALS) (decoders: als)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>musepack7</td>
<td>Musepack SV7 (decoders: mpc7)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>musepack8</td>
<td>Musepack SV8 (decoders: mpc8)</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>nellymoser</td>
<td>Nellymoser Asao</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>opus</td>
<td>Opus (Opus Interactive Audio Codec)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>paf_audio</td>
<td>Amazing Studio Packed Animation File Audio</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>pcm_alaw</td>
<td>PCM A-law / G.711 A-law</td>
</tr>
<tr>
<td>.DA.S</td>
<td>pcm_bluray</td>
<td>PCM signed 16</td>
</tr>
<tr>
<td>.DA.S</td>
<td>pcm_dvd</td>
<td>PCM signed 20</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_f32be</td>
<td>PCM 32-bit floating point big-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_f32le</td>
<td>PCM 32-bit floating point little-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_f64be</td>
<td>PCM 64-bit floating point big-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_f64le</td>
<td>PCM 64-bit floating point little-endian</td>
</tr>
<tr>
<td>.DA.S</td>
<td>pcm_lxf</td>
<td>PCM signed 20-bit little-endian planar</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>pcm_mulaw</td>
<td>PCM mu-law / G.711 mu-law</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s16be</td>
<td>PCM signed 16-bit big-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s16be_planar</td>
<td>PCM signed 16-bit big-endian planar</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s16le</td>
<td>PCM signed 16-bit little-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s16le_planar</td>
<td>PCM signed 16-bit little-endian planar</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s24be</td>
<td>PCM signed 24-bit big-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s24daud</td>
<td>PCM D-Cinema audio signed 24-bit</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s24le</td>
<td>PCM signed 24-bit little-endian</td>
</tr>
<tr>
<td>EDA.S</td>
<td>pcm_s24le_planar</td>
<td>PCM signed 24-bit little-endian planar</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
<td>Codec Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>-------------------</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s32be</td>
<td>PCM signed 32-bit big-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s32le</td>
<td>PCM signed 32-bit little-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s32le_planar</td>
<td>PCM signed 32-bit little-endian planar</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s64be</td>
<td>PCM signed 64-bit big-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s64le</td>
<td>PCM signed 64-bit little-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s8</td>
<td>PCM signed 8-bit</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_s8_planar</td>
<td>PCM signed 8-bit planar</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u16be</td>
<td>PCM unsigned 16-bit big-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u16le</td>
<td>PCM unsigned 16-bit little-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u24be</td>
<td>PCM unsigned 24-bit big-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u24le</td>
<td>PCM unsigned 24-bit little-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u32be</td>
<td>PCM unsigned 32-bit big-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u32le</td>
<td>PCM unsigned 32-bit little-endian</td>
</tr>
<tr>
<td>EDA..S</td>
<td>pcm_u8</td>
<td>PCM unsigned 8-bit</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>pcm_zork</td>
<td>PCM Zork</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>qcelp</td>
<td>QCELP / Qualcomm® PureVoice®</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>qdm2</td>
<td>QDesign Music Codec 2</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>ra_144</td>
<td>RealAudio® 1.0 (14.4K) (decoders: real_144) (encoders: real_144)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>ra_288</td>
<td>RealAudio® 2.0 (28.8K) (decoders: real_288)</td>
</tr>
<tr>
<td>.DA.S</td>
<td>ralf</td>
<td>RealAudio® Lossless</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>roq_dpcm</td>
<td>DPCM id RoQ</td>
</tr>
<tr>
<td>EDA..S</td>
<td>s302m</td>
<td>SMPTE 302M</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>sdx2_dpcm</td>
<td>DPCM Squareroot-Delta-Exact</td>
</tr>
<tr>
<td>.DA..S</td>
<td>shorten</td>
<td>Shorten</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>sipr</td>
<td>RealAudio® SIPR / ACELP.NET</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>smackaudio</td>
<td>Smacker audio (decoders: smackaud)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>sol_dpcm</td>
<td>DPCM Sol</td>
</tr>
<tr>
<td>EDA...</td>
<td>sonic</td>
<td>Sonic</td>
</tr>
<tr>
<td>.DA..S</td>
<td>tak</td>
<td>TAK (Tom's lossless Audio Kompressor)</td>
</tr>
<tr>
<td>EDA..S</td>
<td>truehd</td>
<td>Dolby® TrueHD</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>truespeech</td>
<td>DSP Group TrueSpeech</td>
</tr>
<tr>
<td>EDA..S</td>
<td>tta</td>
<td>TTA (True Audio)</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>twinvq</td>
<td>VQF TwinVQ</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>vmdaudio</td>
<td>Sierra Entertainment VMD audio</td>
</tr>
<tr>
<td>Legend</td>
<td>Codec</td>
<td>Codec Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>-------------------</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>vorbis</td>
<td>Xiph.Org” Vorbis</td>
</tr>
<tr>
<td>.DA...</td>
<td>wavesynth</td>
<td>Wave synthesis pseudo-codec</td>
</tr>
<tr>
<td>EDA.LS</td>
<td>wavpack</td>
<td>WavePack</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>westwood_snd1</td>
<td>Westwood Studios Audio (SND1) (decoders: ws_snd1)</td>
</tr>
<tr>
<td>.DA.S</td>
<td>wmalossless</td>
<td>Windows Media® Audio Lossless</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>wmapro</td>
<td>Windows Media® Audio 9 Professional</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>wma1</td>
<td>Windows Media® Audio 1</td>
</tr>
<tr>
<td>EDA.L.</td>
<td>wma2</td>
<td>Windows Media® Audio 2</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>wmavoice</td>
<td>Windows Media® Audio Voice</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>xan_dpcm</td>
<td>Electronic Arts DPCM Xan</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>xma1</td>
<td>Xbox® Media Audio 1</td>
</tr>
<tr>
<td>.DA.L.</td>
<td>xma2</td>
<td>Xbox® Media Audio 2</td>
</tr>
</tbody>
</table>

### To Import Media Files

Transcode a media file of a different format to a clip that can be played in the server.

**Note:** Ensure that [Mira Import](#) is properly configured for the type of import you want to perform. For example, if you are importing a Multi-Screen image, you must configure the import for the size of the canvas and codec you are using.

**Tip:** You can close the [Mira Import](#) application at any point during an import to stop the process and release the channel. When you start the [Mira Import](#) application again, it will detect the import queue and prompt you to resume.

1. Launch the [Mira Import](#) application.
2. In the **Import Method** list, select the how you want to import the media file.
   - **Software Transcode** — use the software based transcoder to import the media file that is in a different media format than your hardware.
   - **Native Import Only: No Transcoding** — import the media file that is in the native media format for your hardware.

   **Tip:** Select **Native Import Only** if the file you are importing is one of the following or use the **Software Transcoder** for any published codec. No channels are consumed for either of these operations.
   - **Abekas JPEG-2000.clip** — if your server is equipped with the JPEG-2000 video hardware.
   - **DVCPRO-HD.mov/.mxf** — if your server is equipped with the DVCPRO-HD video hardware.
   - **AVC-Intra 100.mov/.mxf** — if your server is equipped with the AVC-Intra video hardware.

The [Mira Import](#) window is shown.
3. Click **Import From** and select the folder that the media files you want to import are located in.

   **Tip:** If you want to point the import application to a network drive, you must map that drive in Windows® before you can select it as a source.

4. Click **Choose**.

5. Click **Destination** and select the `H:\Video` folder, or a folder below this one, on the media drive.

   **Note:** The destination must be under the `H:\Video` folder on the media drive or the imported files will not be available to the server.

6. Click the green add files (+) button and select the media files that you want to import.

7. Click **Add Files**.

   **Tip:** If you want to remove files from the import list, select the files and click the red remove files (-) button. The files are not deleted, only removed from the import queue.

   **Tip:** You can change the order that the files are imported by selecting the file(s) you want to move and click the up or down arrow buttons on the right of the window. The file(s) are moved up or down in the list. You can also drag and drop the files to order the files.

### To Configure Mira Import

The **Mira Import** configuration menus allow you to change the destination folder, set how the RGB color space is interpreted, the raster size of the imported video, set up a watch folder, and to set an auto start behavior.

1. Launch the **Mira Import** application.

2. In the **Import Method** list, select the how you want to import the media file.

   - **Software Transcode** — use the software based transcoder to import the media file that is in a different media format than your hardware.
   - **Native Import Only: No Transcoding** — import the media file that is in the native media format for your hardware.

   **Tip:** Select **Native Import Only** if the file you are importing is one of the following or use the **Software Transcoder** for any published codec. No channels are consumed for either of these operations.

   - *Abekas JPEG-2000.clip* — if your server is equipped with the JPEG-2000 video hardware.
   - *DVCPro-HD.mov/.mxf* — if your server is equipped with the DVCPro-HD video hardware.
   - *AVC-Intra 100.mov/.mxf* — if your server is equipped with the AVC-Intra video hardware.

The **Mira Import** window is shown.
3. Click **Edit > Configure**.
4. Click the **Destination** tab and click **Change** and select a new destination folder for import.

5. Click the **Color** tab and select how the RGB luminance color range is interpreted when a file is imported.

   - **Normal** — color luminance range is scaled from 0 to 255.
   - **Prescaled to 10-235** — color luminance range is scaled from 10 to 235.

   **Tip:** If the blacks of your imported media files appear crushed or the whites do not appear as bright as expected, try selecting the opposite mode.

   **Tip:** Select **Normal** if you are importing a media file with alpha (key). The alpha may not import properly otherwise.

6. Click the **Import Codec** tab and select codec you want to use when a file is imported.
- **QuickTime** — use the Apple® QuickTime® codec.
  
  *Note:* Multi-Screen import while operating in 1080p or UHDTV1 is only supported with the QuickTime® codec.

- **FFmpeg** — use the FFmpeg™ codec.
Mira Explorer

Mira Explorer is a Windows® application that provides a graphical interface to the operation of the server. Although this application allows you to control the operation of the server, it does not need to be running for the server to operate.

You can quit Mira Explorer at any time without affecting any of the active real-time video and audio recording and playback operations.

Tip: The Library, Export Editor, and Export Queue buttons at the top of the window allow you to quickly switch between the Clip Library and the export modes.

Tip: A yellow bar will appear at the bottom of the window to provide status updates on various services running on the server.

Mira Explorer Login

When you launch Mira Explorer you have the option of logging in as an administrator, privileged user, or guest user. Each of these types have specific privileges that are assigned by the administrator account.

• Administrator — full access to all features of the application and can set the privileges for the other account types. This account is password protected by default.
• Privileged User — the default account type for using the application. This account is not password protected by default.
• Guest User — a secondary user account if you want to give limited access to the application. This account is not password protected by default.

To Log In to Mira Explorer

1. Open the Mira Explorer application.
2. In the Login Type box select the type of account you want to log in as.
   • Administrator
   • Privileged User
   • Guest User

3. If required, enter a password in the Enter Password field.
   • Administrator — default password is multiflex
   • Privileged User — no password by default
   • Guest User — no password by default

4. Click OK.

Managing Accounts

The administrator account has access to all of the features of the server, as well as the ability to assign privileges to the other accounts.

To Set Account Permissions

The different types of accounts can have different permissions. Only the Administrator account must have permission to set the permissions for other types of accounts.

1. Log into Mira Explorer as the Administrator.
2. Click Configure > General Configuration and click the Permissions tab.

3. Select those permissions you want assigned to each account.
   The Guest User account cannot have permission to set passwords or set user permissions.

4. Click OK.

To Set Account Passwords

Only the Administrator and Privileged User accounts can have a password.
1. Log into **Mira Explorer** as the Administrator.

2. Click **Configure > General Configuration** and click the **Passwords** tab.

3. Enter the new password for the account you want to set the password for. Passwords can use letters, numbers, and special characters, and are case-sensitive.

   **Tip:** If the **Privileged User password** field is left blank, you will not be prompted to enter a password when logging in with that account.

4. Click **OK**.
# Channel Transport Control

Each channel in the server has a dedicated channel transport in **Mira Explorer** that is used to load, play, record, and seek within clips. Clips are loaded into the channel transport from the Clip Library.

*Note: When video channels are configured for multiple ISO cameras, the Video Windows for all channels included in the ISO are displayed in the master channel transport. Channel REC-1 will be the leftmost video window with the remaining channels in order.*

1. **Active Channel** — The channel transport that is currently selected. Keyboard commands and clip selections are applied to this channel.
2. **Video Window** — Shows the full-motion video output of the channel. This can be the clip that is currently playing or the live video input to the channel when EE is on.
3. **Load Clip** (Hold Shift + Enter) — Load the selected clip in the Clip Library into this channel. Press and hold the Shift button and press Enter to eject the clip.
4. **Clip Name** — The name of the clip currently loaded into the channel transport.
5. **Activity Indicator** — Shows the current activity of the channel transport. **RECORDING** when the channel transport is actively recording, **IMPORTING** when the channel transport is actively importing, and **EXPORTING** when the channel transport is actively exporting.
6. **Jog** (Hold Enter) — Jog forward or reverse by one frame/field in the active clip.
7. **Rewind** — Rewind the current clip at 30-times normal speed.
8. **Play Reverse** — Play the current clip in reverse at 1-times normal speed.
9. **Stop** — Stops playback or recording on the current channel transport.
10. **Record** — Opens the Record Setup dialog to assist in recording a clip. *Note: Record is only supported on the Record (REC) channel transports.*
11. **Play Forward** — Play the current clip forward at 1-times normal speed.
12. **Fast Forward** — Fast-Forward the current clip at 30-times normal speed.
13. **Timecode** — Shows the timecode value of the current position in the clip. An f1 or f2 at the end of the timecode indicates Field playback (interlaced), and an f1-f2 indicates Frame playback (progressive). *Tip: Double-click on the timecode to enter a new timecode value manually. The channel transport immediately seeks to that timecode in the clip once you press Enter.*
14. **Count-Down Timer** — Shows the time remaining in the current clip. When the clip reaches the end the timer will show 00.00.00.
15. **EE** — Turns EE (Electronic to Electronic) mode On/Off for the selected channel transport. Also called bypass mode where the video signal coming into the video channel is routed directly to the output without being stored and read from disk. *Note: The EE mode is only supported on the Record (REC) channel transports.*
16. **Seek to Start** — Seek to the first frame of the clip.
17. **Play Repeat Normal** ( NORMAL ) — Normal play mode where the clip plays to the end and stops. Only one play repeat mode can be active at one time.

18. **Play Repeat Ping-Pong** ( PINGPONG ) — Ping-pong repeat mode where the clip plays back and forth between the in and out points stored in the clip.

19. **Play Repeat Loop** ( LOOP ) — Loop repeat mode where the clip starts playing again from the in point after it reaches the out point.

   **Note:** If the channel transport is being controlled externally using the Odetics protocol, this button is disabled.

20. **Play Repeat Loop to Play** ( MUL ) — Multipoint repeat mode (also known as 3-Point Loop mode) where the clip can start playing from a point before the in point but starts playing again from the in point when it reaches the out point. The clip will continue to loop between the in point and out point from then on.

   **Tip:** Clicking **Play Repeat Normal** allows the clip to ignore the out point and play through to the end frame of the clip. This does not interrupt the loop play in progress.

21. **Play Speed** — Shows the current play speed of the clip.

   **Tip:** Double-click on the play speed to enter a new play speed manually as a percentage. The clip will start playing at the new speed once you press Enter.

22. **Clip Position Slider Handle** — Indicates the current point in the clip that is being played. You can drag the handle back and forth to select a different point in the clip. Playback stops if you move the slider handle.

23. **Clip Position Slider Bar** — A graphical representation of the current clip. When the clip is playing or recording, the slider handle moves along the slider bar showing real-time progress through the clip. The slider handle and bar are green when playing and red when recording.

24. **Seek to End** ( SEEK ) — Seek to the last frame of the clip.

25. **Chain** ( CHAIN ) — Selects whether a channel transport is ganged with other channel transports. When **Chain** is turned on for a channel transport, that channel transport becomes linked to the other channel transports in the chain in Mira Explorer. Within Mira Explorer, any transport commands run on one channel transport in the chain are frame-accurately duplicated on all the other channel transports in the same chain. Commands sent to a channel transport from an external device over serial/ethernet control are not chained to the other channels.

   **Note:** Record and Load/Eject Clip are not support as chained commands and will only be performed on the channel transport that you run them on.

### To Load a Clip

The clip can start to play as soon as it is loaded into a channel transport.

1. Select the channel transport you want to load a clip into.
2. Double-click the clip you want to load into the transport control. The clip must be in the same video format that the server is operating in.

   **Tip:** You can also drag and drop the clip onto the channel transport area, or click the load clip button ( ) next to the clip name in the transport control area.

   **Tip:** Click the up arrow next to the Clip Library title to expand the listing. Only the selected channel transport is shown with the expanded library list. Click the same button again to return the list to normal.

The clip is loaded into the channel transport and the transport control buttons become active. The first frame of the clip is shown in the preview window in the transport control area. If you are using a remote Mira Explorer client, the preview window is not available.
To Play a Clip

Clips can play automatically once loaded, loop, or play at faster or slower speeds.

1. Load the clip or playlist you want to play into the channel transport you want to play it out on.
2. Click the play button (▶).

The clip starts to play on the selected channel transport.

To Unload a Clip

Remove a clip from the current channel transport.

1. Select the channel transport you want to eject a clip from.
2. Press and hold the Shift button and press F1 to eject the clip.

The clip is unloaded from the channel transport and color bars are loaded into the preview window and video output of the selected channel.

Clip Repeat Modes

There are a number of ways to have a clip continuously loop when playing out. These modes can be set in the metadata of a clip so that the clip always loads in this mode. They can also be set manually from the channel transport controls, or they can be set remotely from an external device.

Only one play repeat mode can be active at a time.

Tip: Repeat modes use Play Repeat IN and Play Repeat OUT points to determine what video to repeat. The default values for these points are stored in the metadata of the clip.

Normal (Off)

This is the normal play mode (▶) where the clip plays to the end and stops. This mode is automatically set if you are controlling the channel transport from an external device, such as a switcher.

Loop

The repeat mode (▶) where the clip starts playing again from the in point again after it reaches the out point. When the clip starts playing, it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT point. When it reaches the Play Repeat OUT point it seeks back to the Play Repeat IN point and plays again. The clip will continue to play like this until stopped.

Ping-Pong

The repeat mode (▶) where the clip plays back and forth between the in and out points. When the clip starts playing, it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT point. When it reaches the Play Repeat OUT point it starts playing in reverse until it reaches the Play Repeat IN point again. The clip will continue to play like this until stopped.

Loop to Play

The Multipoint (3-Point Loop) repeat mode (▶) where the clip can start playing from a point before the in point but starts playing again from the in point when it reaches the out point. The clip starts playing from the beginning passing through the Play Repeat IN point and continues playing until it reaches the Play Repeat OUT point. When it reaches the Play Repeat OUT point it seeks back to the Play Repeat IN point and plays again. The clip will continue to play like this until stopped.

The portion of the clip before the Play Repeat IN point is only played the first time. This can be used if the repeating portion of the clip has a lead-in at the beginning. The lead-out portion of the clip can be played by switching the clip to the normal (▶) mode after the last repeat has started. The clip will then play to the end.
Recording a Clip

When recording a clip you can record a new clip, append to the end of an existing clip, or overwrite an existing clip. Clips can be recorded to the root, or a sub-folder in the Clip Library.

Tip: If you want to quickly record a clip using the same settings as the last time you recorded, press and hold the Shift button and click the record button ( ).

To Record a New Clip

Use a channel transport to record the video signal coming into the server.

Note: You cannot record a separate key video + alpha channel. You can only import clips with key video and alpha channels.

1. Select the channel transport that you want to record a clip to. This is the channel for the BNC on the back of the server that the audio/video you want to record is coming in on. Not all channels will have an associated input BNC, depending on the model and configuration of your server.
2. Eject any clip that may already be loaded into the channel transport.
3. Click the record button ( ).

The Clip Record Setup dialog box is shown.

4. In the Record Type area, select the type of recording you want to do.
   • New Clip (Record After Arming) — arms the channel transport for recording a new clip.
5. In the Record Tracks area, select which tracks you want to record.
   Note: Audio is recorded depending on how the Audio Input Source is set in Mira Config.
   • Video — record the video and any embedded audio coming into the Video In BNC, depending on the audio source.
   • Audio — record the digital audio coming into the AES ports or the embedded audio on the Video In BNC, depending on the audio source.
6. In the New Clip area, enter a name for the clip in the Clip Name field.
   Tip: If you want to record the clip into a sub-folder on the media drive you must include the folder path with the new. For example, 1080p Clips\Downtown-Fire records the clip Downtown-Fire in the 1080p Clips folder. The folder must already exist in the Clip Library to be able to record to it.
7. Enter an 8-character id for the clip in the Clip ID field.
If you are controlling the server from an external device, the clip id is used on the external device to load a clip. If you do not assign a clip id to the clip, the first 8 characters of the clip name can be used.

8. Turn **Auto Name** on if you want to create a series of clips with the same name plus an identifier.
   - **Off** — overwrite any existing clip of the same name.
   - **Numeric Append** — add a numeric digit to the end of the new clip name and increment it by one with each new clip of the same name.
   - **Time of Day** — add the current date and time to the end of the clip name.
   - **LTC In** — add a timecode stamp from the embedded timecode in the video signal being recorded.

9. Select a **Timecode** source for the new clip.
   - **Striped** — use the internally generated timecode data. The starting point for the timecode is set in the **Starting at** field.
   - **External TC** — use the timecode data embedded in the video signal being recorded.

10. Click **OK**.
    The channel transport is now armed to record. The video window shows live video coming into the channel, the EE button is on, and the record button ( ) is flashing.

11. Click the flashing record button ( ) when you are ready to record.
    The server starts recording, the EE button goes off, and name of the new clip is shown at the top of the channel transport area, and the **RECORDING** indicator appears.

12. Click the stop ( ) button to stop recording.

**To Overwrite/Append to a Clip**
Add to the end of an existing clip, or overwrite the clip entirely.

*Note: You cannot record a separate key video + alpha channel. You can only import clips with key video and alpha channels.*

1. Select the channel transport that you want to record a clip to. This is the channel for the BNC on the back of the server that the audio/video you want to record is coming in on. Not all channels will have an associated input BNC, depending on the model and configuration of your server.

2. Prepare the channel transport for the type of recording you want to do.
   - **Append** — load the clip that you want to append the new recording to.
   - **Overwrite** — load the clip that you want to overwrite and seek to the point in the clip that you want to start the new recording.

3. Click the record button ( ).
   The **Clip Record Setup** dialog box is shown.
4. In the **Record Type** area, select the type of recording you want to do.
   - **Append** — arms the channel transport to start recording at the end of the current clip.
   - **Overwrite** — arms the channel transport to start recording at the currently selected point in the exiting clip. Everything after this point in the clip will be overwritten.

5. In the **Record Tracks** area, select which tracks you want to record.
   
   **Note:** Audio is recorded depending on how the Audio Input Source is set in **Mira Config**.
   
   - **Video** — record the video and any embedded audio coming into the Video In BNC, depending on the audio source.
   - **Audio** — record the embedded audio on the Video In BNC, depending on the audio source.

6. Click **OK**.
   The channel transport is now armed to record. The video window shows live video coming into the channel, the EE button is on, and the record button ( ) is flashing.

7. Click the flashing record button ( ) when you are ready to record.
   The server starts recording, the EE button goes off, the name of the new clip is shown at the top of the channel transport area, and the **RECORDING** indicator appears.

8. Click the stop ( ) button to stop recording.

**Locking Channel Transport Control**

You can lock any channel transport control in **Mira Explorer**. This prevents someone from accidentally loading or ejecting a clip, or using any of the transport controls.

**Note:** Locking a channel transport does not prevent the external control of that channel.

**To Lock/Unlock a Channel Transport**

Lock a channel so that it can’t be accidentally changed directly. Chained, or ganged, channels are not affected by the lock.

Press and hold the **Ctrl** button and click on the channel transport that you want to lock/unlock.
The channel transport controls are grayed out and a lock symbol is shown over the controls when the channel transport is locked.

**Keyboard Shortcuts**

These keyboard shortcuts work on the currently selected video channel transport in the Mira Explorer window.

*Tip: Two or more video channel transports can be linked together (Chained) so that commands sent to one channel are also sent to the others. Not all the keyboard shortcuts support Chain control.*

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Description</th>
<th>Chain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Screen</td>
<td>F11</td>
<td>(Windows® shortcut) Sets the Mira Explorer window to full screen mode, or back to windowed mode.</td>
<td>No</td>
</tr>
<tr>
<td>Change Application</td>
<td>Alt+Tab</td>
<td>(Windows® shortcut) Switch between Windows® applications.</td>
<td>No</td>
</tr>
<tr>
<td>Select Channel A</td>
<td>Ctrl+1 A</td>
<td>Selects channel A as the active channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Chain Channel Transport Control</td>
<td>Ctrl+1 C</td>
<td>Clear all Channels — set all channel chain controls to Off.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+1 Y</td>
<td>Chain Current Channel — turn channel chain control On for the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+1 N</td>
<td>Unchain Current Channel — turn channel chain control Off for the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+1 T</td>
<td>Toggle Chain Current Channel — toggles the chain control On or Off for the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Stop/Play</td>
<td>(spacebar)</td>
<td>Stop or Play on the selected channel transport.</td>
<td>Yes</td>
</tr>
<tr>
<td>EE</td>
<td>Ctrl+E Y</td>
<td>EE On — turn EE (Electronic to Electronic) mode On for the selected channel transport. Also called bypass mode where the video signal coming into the server is routed directly to the output without being stored and read from disk.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+E N</td>
<td>EE Off — turn EE mode Off for the selected channel transport. The video output comes from the disk.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+E T</td>
<td>EE Toggle — toggles EE mode On or Off for the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Load</td>
<td>F1</td>
<td>Load the highlighted clip in the Clip Library into the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Unload</td>
<td>Shift+F1</td>
<td>Unloads the clip from the selected channel transport and loads a color-bar test pattern.</td>
<td>No</td>
</tr>
<tr>
<td>Jog Reverse</td>
<td>F3</td>
<td>Reverse the clip in the selected channel transport by one frame/field. Press and hold the button to play the clip in reverse at 33% speed.</td>
<td>Yes</td>
</tr>
<tr>
<td>Jog Forward</td>
<td>F4</td>
<td>Advance the clip in the selected channel transport forward by one frame/field. Press and hold the button to play the clip forward at 33% speed.</td>
<td>Yes</td>
</tr>
<tr>
<td>Rewind</td>
<td>F6</td>
<td>Rewind the clip in the selected channel transport.</td>
<td>Yes</td>
</tr>
<tr>
<td>Function</td>
<td>Shortcut</td>
<td>Description</td>
<td>Chain</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Play Reverse</td>
<td>F7</td>
<td>Play the clip in the selected channel transport in reverse.</td>
<td>Yes</td>
</tr>
<tr>
<td>Stop</td>
<td>F8</td>
<td>Stop playing or recording the clip in the selected channel transport.</td>
<td>Yes</td>
</tr>
<tr>
<td>Play</td>
<td>F9</td>
<td>Play the clip in the selected channel transport.</td>
<td>Yes</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>F10</td>
<td>Fast-forward the clip in the selected channel transport.</td>
<td>Yes</td>
</tr>
<tr>
<td>Seek to Start of Clip</td>
<td>Ctrl+F6</td>
<td>Seek to the first frame of the clip in the selected channel transport and stop.</td>
<td>Yes</td>
</tr>
<tr>
<td>Seek to End of Clip</td>
<td>Ctrl+F10</td>
<td>Seek to the last frame of the clip in the selected channel transport and stop.</td>
<td>Yes</td>
</tr>
<tr>
<td>Cue Points</td>
<td>Ctrl+`</td>
<td>Mark a cue point in the selected channel transport, or remove the current cue point.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Left</td>
<td>Seek backwards to the next cue point in the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Right</td>
<td>Seek forwards to the next cue point in the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Variable Play</td>
<td>F12</td>
<td>1× Forward — play the clip in the selected channel transport forward at 1 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F13</td>
<td>3× Forward — play the clip in the selected channel transport forward at 3 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F14</td>
<td>4× Forward — play the clip in the selected channel transport forward at 4 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F15</td>
<td>8× Forward — play the clip in the selected channel transport forward at 8 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F16</td>
<td>16× Forward — play the clip in the selected channel transport forward at 16 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F17</td>
<td>30× Forward — play the clip in the selected channel transport forward at 30 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>F18</td>
<td>0.33× Forward — play the clip in the selected channel transport forward at 33% of 1 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F11</td>
<td>0.33× Reverse — play the clip in the selected channel transport backwards at 33% of 1 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F12</td>
<td>1× Reverse — play the clip in the selected channel transport backwards at 1 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F13</td>
<td>3× Reverse — play the clip in the selected channel transport backwards at 3 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F14</td>
<td>4× Reverse — play the clip in the selected channel transport backwards at 4 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F15</td>
<td>8× Reverse — play the clip in the selected channel transport backwards at 8 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F16</td>
<td>16× Reverse — play the clip in the selected channel transport backwards at 16 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F17</td>
<td>30× Reverse — play the clip in the selected channel transport backwards at 30 times speed.</td>
<td>Yes</td>
</tr>
<tr>
<td>Trim</td>
<td>Ctrl+T H</td>
<td>Head — trim head from the clip in the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+T T</td>
<td>Tail — trim tail from the clip in the selected channel transport.</td>
<td>No</td>
</tr>
<tr>
<td>Function</td>
<td>Shortcut</td>
<td>Description</td>
<td>Chain</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Gang All</td>
<td>Ctrl+G P</td>
<td><strong>Gang Play</strong> — play all clips loaded in all channel transports.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+G S</td>
<td><strong>Gang Stop</strong> — stop all clips loaded in all channel transports.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ctrl+G R</td>
<td><strong>Gang Re-cue</strong> — re-cue all clips loaded in all channel transports.</td>
<td>Yes</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+2 N</td>
<td><strong>New Clip Record</strong> — creates a new clip in the Clip Library, loads it into Channel A Transport, selects LIVE EE mode, and starts recording to that clip.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+2 C</td>
<td><strong>Create and Load New Clip</strong> — creates a new clip in the Channel A Transport with a 1-frame duration and parks on the first frame. It does not start recording.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+2 A</td>
<td><strong>Append Record</strong> — seeks to the end of the clip loaded in Channel A Transport, selects LIVE EE mode, and starts recording to that clip. A clip must be loaded into the Channel A Transport before running this command.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+2 O</td>
<td><strong>Overwrite Record</strong> — selects LIVE EE mode and starts recording over the clip loading in Channel A Transport. The server starts recording over the current clip at the location Channel A Transport is parked.</td>
<td>No</td>
</tr>
<tr>
<td>List Play</td>
<td>Ctrl+L A</td>
<td><strong>Move Cursor to On-Air Item</strong> — selects the item that is currently airing on the on-air playlist.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+L B</td>
<td><strong>Move Cursor to Next On-Air Item</strong> — selects the preview item on the on-air playlist.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+L 1 to L 9</td>
<td><strong>Move Cursor to On-Air Item X</strong> — selects item X (1 to 9) on the on-air playlist.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+L Y</td>
<td><strong>List Play Loop Mode ON</strong> — turns looping on for the on-air playlist. The entire contents of the playlist is looped.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+L L N</td>
<td><strong>List Play Loop Mode OFF</strong> — turns looping off for the on-air playlist.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ctrl+L L T</td>
<td><strong>List Play Loop Mode Toggle</strong> — toggles looping on or off for the on-air playlist.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Enter</td>
<td><strong>Take</strong> — takes the next item on the on-air playlist. The Enter button found with the numeric keypad of your keyboard does not work for this command.</td>
<td>No</td>
</tr>
</tbody>
</table>
Clip Library

The Clip Library appears on the bottom half of the Mira Explorer window and shows all the media file clips that are currently available to the server. These clips can be located on the internal media drive of the Mira Express or on the media drive of a separate Mira Express. The list can be filtered using the Display Clips selection at the top of the list.

Tip: You can change the width and position of each column in the list, as well as sort the list based on the information in any column. You can select which columns are shown from the Clip Library > Select Columns.

- **Cueable Local** — show only those clips that are in the same video format that the server is operating in and are stored on the local media drive.
- **All Local** — show all clips that are stored on the local media drive. Clips that are not in the same video format that the server is operating in are displayed, but cannot be loaded.
- **Remote** — show only those clips that are located on a remote server. You cannot load clips from a remote server into channel transports on your local server.

Search

You can search the Clip Library for clip names that contain a specific word.

Enter the name of a clip you want to find in the search field located to the right of the Clip Library title bar. The Clip Library will only show those clips that match your search criteria and the number of clips shown is indicated in yellow at the bottom.

Play Lists

A Play List is a collection of clips that are sorted into the order you want them played. Play Lists are created and edited within the Clip Library.
To Create/Edit a Play List

Create the Play List and add the clips. Arrange the clips in the order you want them to play and set how you want to transition between clips and the speed you want the clip to play out when the Play List is played.

1. If you are creating a new Play List, click New > New Playlist and enter a name for the new Play List. If you are editing a Play List, proceed to the next step.
2. Double-click on the name of the Play List you just created. The Playlist Editor opens to the right of the Clip Library.
3. Drag and drop clips from the Clip Library to your Play List.
   Tip: Right-click on a clip and click Remove from list to remove the clip from the Play List.
4. Drag and drop clips within the Play List to order them how you want them to play out.
5. Set a different behaviour for the start (@START) of a clip by right-clicking on the clip and selecting Set @START. 
   - Play — the clip plays out automatically when the Play List transitions to this clip in ON-AIR mode. This is the default setting.
   - Pause — the clip is paused on the first frame when the Play List transitions to this clip in ON-AIR mode.
6. Set a different behaviour for the end (@END) of a clip by right-clicking on the clip and selecting Set @END.
   - Take — the Play List transitions to the next clip in ON-AIR mode. This is the default setting.
   - Pause — the clip is paused on the last frame when it reaches the end of the clip in ON-AIR mode. You must click TAKE to transition to the next clip.
   Tip: You can press Enter on the keyboard to transition to the next clip, instead of clicking TAKE.
   - Loop — the clip is looped when it reaches the end of the clip in ON-AIR mode. You must click TAKE to transition to the next clip.
7. Set a different transition length (TRANS) for the transition between the current clip and next by right-clicking on the clip and selecting Set Transition....

<table>
<thead>
<tr>
<th>Note: The dissolve transitions (MIX) require two channel transports (PGM/PVW) to be able to transition from one channel to the other (one clip to the other). The dissolve is applied between the two clips.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• CUT — a cut is performed between the clips.</td>
</tr>
<tr>
<td>• 0.05 MIX — a 5-frame dissolve is performed between clips.</td>
</tr>
<tr>
<td>• 0.10 MIX — a 10-frame dissolve is performed between clips.</td>
</tr>
<tr>
<td>• 0.15 MIX — a 15-frame dissolve is performed between clips.</td>
</tr>
<tr>
<td>• 0.20 MIX — a 20-frame dissolve is performed between clips.</td>
</tr>
<tr>
<td>• 1.00 MIX — a 1-second dissolve is performed between clips.</td>
</tr>
</tbody>
</table>

8. Click Save to save the changes to the playlist.

| Tip: Click Save and AIR List to save the changes to the PlayList and load the Play List into the selected channel transport. |

**To Air a Play List**

Take the Play List on-air to play each clip in order with the set transitions.

| Note: If you want to use mix transitions between the clips in the Play List you must use two channel transports. Depending on the channel transport you select, the following channel transport is used for preview. |

1. Double-click on the playlist you want to air in the Clip Library.
2. Select the channel transport that you want to play the Play List on.
3. Click AIR List on the Playlist Editor window.

   The Playlist Editor window changes to the PLAYLIST ON-AIR window, and the first clip in the Play List is highlight red and is loaded into the selected channel transport.

4. If you want to dissolve (mix) from one clip to the next in the Play List select PGM-2 > PGM-1. If not selected, the Play List will cut from one clip to the next.

   You are prompted whether you want to load the list in PGM/PVW mode. Click Yes. The next clip in the Play List (highlighted green) is loaded into the second (PVW) channel transport.

5. Click play ( ) to start playing the Play List.

   | Tip: Click the loop button ( ) to have the Play List start again at the beginning when it finishes the last clip. It is recommended that you set @START to PLAY and @END to TAKE to fully automate the loop. |

   The first clip starts to play out and execute the @Start, @End, and transition tags of the current clip. When the clip is close to the end (3 seconds) the next clip highlights yellow, indicating that the PVW channel is about to go on-air as part of the transition.
Tip: When you are finished using the playlist feature, click **EXIT** to take the playlist off-air and free up the channel transports for other uses.

**Play List Commands**

As a Play List is playing out you can skip items in the Play List, cue up segments with manual or immediate playout, or re-cue to the start of the Play List. When you jump to a new location in the Play List, the server continues to play the clips in the Play List from the new location.

To access the list of commands, right-click on the clip you want to cue or play.

- **Play this segment next** — play the selected clip after the currently playing clip finishes on the PGM channel. The clip is highlighted green and is played next.
- **Cue this segment next** — cue the selected clip after the currently playing clip finishes on the PGM channel. The clip is highlighted green and is cued next. The clip pauses at the first frame and must be played manually.
  
  **Tip:** You can manually play the clip by pressing the **Spacebar** on the keyboard.

- **Play this segment immediately** — immediately load and play the selected clip on the PGM channel.
- **Cue this segment immediately** — immediately load and cue the selected clip on the PGM channel. The clip pauses at the first frame and must be played manually.
- **Cue to start of playlist immediately** — immediately load and cue the first clip in the Play List on the PGM channel. The clip pauses at the first frame and must be played manually.

  **Tip:** You can quickly take a different clip in the list by selecting the new clip and clicking the **TAKE** button or pressing **Enter** on the keyboard.

**Folders**

Clips are stored on the media drive in the server, or on external servers connected to the server you are using. You can organise the clips into folders on the media drive either from Windows® Explorer or from the Clip Library.

**Important:** You cannot delete a folder from the Clip Library. You can only delete a folder from Windows®.

- To create a folder, right-click on an empty line in the Clip Library and click **New Folder**.
- You can type in a name for the new folder and drag and drop clips into it.

**Clip Library Columns**

You can set up the Clip Library to show or hide specific columns. Any column, with the exception of the clip name column, can be shown or hidden.

- To change the columns, click **Clip Library > Select Columns**.
- Select which columns you want to show, or deselect the columns you want to hide, and click **OK**.
Clip Metadata

Clip metadata includes information like the name of the clip, the repeat mode, timecode source, and trim points. This information is stored with the clip and is copied to other servers with the clip.

*Note:* You cannot edit the metadata of a clip (Abekas®.CLIP) if it is locked. You must unlock the clip before you can edit the metadata.

*Tip:* Most metadata shown in the Clip Library can be edited directly by double-clicking on the cell in the table and either entering the new data or selecting it from a drop-down list.

To Edit the Label Metadata of a Clip

The label metadata is shown in the Clip Library and is used to sort and identify clips.

1. Select the clip in the Clip Library you want to edit the metadata for.

   *Note:* You cannot edit the metadata of a clip if it is locked.

2. Click **Clip Library > Modify...**

3. Click on the **Labels** tab.

4. Edit the metadata item you want to change.
   - **Comments** — a 255-character free form field.
   - **Project Name** — a 255-character free form field.
   - **Creator** — a 255-character free form field.
   - **Keywords** — 6 independent 35-character searchable words. A keyword can only be a single word or conjunction without spaces.

5. Click **OK**.

To Edit the Attributes Metadata of a Clip

The attributes metadata sets the default output mode for the clip, as well as the repeat function.

1. Select the clip in the Clip Library you want to edit the metadata for.

   *Note:* You cannot edit the metadata of a clip if it is locked.

2. Click **Clip Library > Modify...**

3. Click on the **Attributes** tab.
4. In the **Output Mode** area, select the output video mode that you want to clip to play out in.
   - **Frame** — select this option if the clip was shot in a progressive video format.
   - **Field VI** — select this option if the clip was shot in an interlaced video format and you want to apply vertical interpolation (VI) to it. This mode is useful for clips that will be played out in slow motion or will be frequently paused. The VI helps to eliminate vertical hopping during slow motion playback and jagged edges in paused images.
   - **Field** — select this option if the clip was shot in an interlaced video format and you don’t want to apply vertical interpolation (VI) to it.

   **Note:** The server does not support video format conversion. If a clip is in a different video format than the server is operating in you will not be able to load it into a channel transport.

5. In the **Play Repeat** area, select the repeat mode you want to use for the clip.
   - **OFF** — play repeat is turned off by default when the clip is loaded.
   - **Loop** — play repeat loop is turned on by default when the clip is loaded. When the clip starts playing, it immediately seeks to the **Play Repeat IN** point and plays until it reaches the **Play Repeat OUT** point. When it reaches the **Play Repeat OUT** point it seeks back to the **Play Repeat IN** point and plays again.
   - **Ping Pong** — play repeat ping-pong is turned on by default when the clip is loaded. When the clip starts playing, it immediately seeks to the **Play Repeat IN** point and plays until it reaches the **Play Repeat OUT** point. When it reaches the **Play Repeat OUT** point it starts playing in reverse until it reaches the **Play Repeat IN** point again.
   - **Loop To** — play repeat loop to play is turned on by default when the clip is loaded. The clip starts playing from the beginning passing through the **Play Repeat IN** point and continues playing until it reaches the **Play Repeat OUT** point. When it reaches the **Play Repeat OUT** point it seeks back to the **Play Repeat IN** point and plays again.
   - **Ping Pong To** — play repeat ping pong is turned on by default when the clip is loaded. When the clip starts playing, it immediately seeks to the **Play Repeat IN** point and plays until it reaches the **Play Repeat OUT** point. When it reaches the **Play Repeat OUT** point it starts playing in reverse until it reaches the **Play Repeat IN** point again.

6. Use the **Play Repeat IN** and **Play Repeat OUT** fields to set the timecode for the in and out points of the clip.
   - **Play Repeat IN** — the first inclusive field/frame of the repeated portion of the clip. By default this is the first field/frame of the clip.
   - **Play Repeat OUT** — the field/frame before the last field/frame of the repeated portion of the clip. By default this is one field/frame beyond the end of the clip.
To Edit the Timecode Metadata of a Clip

The timecode metadata sets the source of the timecode information for the clip.

1. Select the clip in the Clip Library you want to edit the metadata for.
   
   **Note:** You cannot edit the metadata of a clip if it is locked.

2. Click **Clip Library > Modify...**

3. Click on the **Timecode** tab.

4. In the **TC Source** area, select the timecode source.
   - **External TC - First Frame Only** — the clip uses the external timecode data of the first field/frame that was originally recorded with the clip. The timecode for the remainder of the clip is synthesized. This option is useful if there was a break or interruption in timecode data during recording.
   - **External TC - Entire Clip Length** — the clip uses the external timecode data that was originally recorded with the clip. This option is useful if the clip has different segments in it with different timecode ranges that you want to use.
   - **Striped** — the clip uses the internally generated, or synthesised, timecode starting at a defined point. Enter the numeric timecode value that you want to use for the start of the clip.

5. In the **Dropframe Flag** area, select if you want to use **Drop frame timecode** or **Nondrop frame timecode**.
   This option is only available if the clip was recorded in a 59.94Hz video format.

6. Click **OK**.

To Edit the Trim Metadata of a Clip

The trim metadata allows you to trim the head or tail off of the clip, setting a new start and end point for the clip. You can also offset a specific track in the clip.

1. Select the clip in the Clip Library you want to edit the metadata for.
   
   **Note:** You cannot edit the metadata of a clip if it is locked.

2. Click **Clip Library > Modify...**

3. Click on the **Trim** tab.
4. In the **Trim In** field, enter the new starting timecode value for the clip. The **Record Start** field shows the timecode at the start of the clip.

5. In the **Trim Out** field, enter the new ending timecode value for the clip. The **Recording End** field shows the timecode at the end of the clip.

6. Use the **Advance** fields to slip the video, audio, or timecode track back in relation to the other tracks in the clip. Only those tracks that are present in the clip are shown.

   Any content slipped past the start of the clip will not be present in the output of the clip.

   **Tip:** Select **Advance by an extra half-frame** to slip that particular track back half of a field/frame.

   - **Advance Video Track** — slip the video track back in time relative to all the other tracks.
   - **Advance Key Track** — slip the key track back in time relative to all the other tracks.
   - **Advance Audio Track** — slip the audio track back in time relative to all the other tracks.
   - **Advance Timecode Track** — slip the timecode track back in time relative to all the other tracks.

7. Click **OK**.

### Parent/Child Clips

You can create virtual copies of a clip. These child clips are essentially pointers to the parent clip that use an independent set of metadata. This allows you to create a number of child clips that are trimmed differently from their parent and each other without taking up additional space on the media drive.

Once a child clip has been created, you cannot delete the parent clip until all the child clips have been deleted.

#### To Create a Child Clip

The child clip can have different metadata from the parent clip.

**Note:** You cannot create a child clip if the parent clip is locked.

1. Right-click on the clip that you want to create a child of.
2. Click **Create Child Clip**.

The child clip appears in the clip list with the same name as the parent clip with - Ch11d appended to the end of the clip name.
Deleting a Clip

By default, you can only delete a single clip at a time. The Administrator and Privileged User accounts can be granted permission to delete multiple clips at once.

**Note:** Only Administrator and Privileged accounts can delete clips from the server.

To Delete a Clip

Remove the clip from the Clip Library and the hard drive of the server.

**Note:** You cannot delete a clip if it is locked. Unlock the clip first and then you can delete it.

1. Select the clip(s) that you want to delete.
   **Note:** Your account must have permission to delete more than one clip at a time.

2. Click Clip Library > Delete.
   You are prompted to confirm the deletion. Click Delete to delete the clip(s).

Lock/Unlock Clips

Clips can only be locked or unlocked from Windows®. When a clip is locked, an orange lock icon is shown in the Locked column in the Clip Library.

To Lock/Unlock a Clip

A clip can only be locked or unlocked from Windows®.

1. Launch Windows® Explorer and navigate to the media drive on the server (Media Data (H):) and open the Video folder.
2. Locate the clip that you want to lock or unlock and right-click on it.
   **Tip:** Select multiple files and right-click on one of them to lock/unlock multiple files at once.

3. Click Properties.
4. Click the General tab and select (locked) or un-select (unlocked) Read-only in the Attributes section.

5. Click OK.
Timecode Chase

A Timecode Chase (TC Chase List) list allows you to create a playlist where each clip in the list can be triggered by a timecode value. For each clip in the list you set the timecode value that you want to clip to start playing. You also have the option of setting a new in point, or offset, for the clip if you don’t want the clip to start playing from the beginning.

**Note:** You must have a valid timecode signal connected to the LINE IN port at the back of the server.

**Tip:** Because the TC Chase List does not use the LTC IN port, you can still use time of day LTC input separate from TC Chase List.

To Create a TC Chase List

You can add clips to the TC Chase List in the same way you add clips to a Play List. Once the clips have been added you can set the timecode value for when each clip will start playing, as well as any offset to the input of the clip that you want to jump to.

1. If you are creating a new TC Chase List, click **New > New Playlist** and enter a name for the new TC Chase List. If you are editing a TC Chase List, proceed to the next step.
2. Double-click on the name of the TC Chase List you just created. The **TC Chase Editor** opens to the right of the Clip Library.

   **Note:** If it appears that the Editor window has not opened, it may be shrunk. Resize the right side of the Clip Library to make the Editor window visible.

   **Tip:** The current timecode coming into the server is shown at the top of the TC Chase List window.

3. Drag and drop clips from the Clip Library to your TC Chase List.

   **Tip:** Right-click on a clip and click **Remove from list** to remove the clip from the TC Chase List.

4. Drag and drop clips within the TC Chase List to order them how you want them to appear visually. The order of the clips in the list does not change the playout order. Clips are played according to their **TC Offset Trigger**.

   **Tip:** You can click **Save** at any time to save the current state of the TC Chase List.

5. Double-click on the time in the **TC Offset Trigger** column for the clip you want to edit and enter the timecode value at which you want this clip to start playing. For example, if you want the clip to start playing at timecode 01,00,30,00, enter 01 , 00 , 30 , 00.
6. If required, double-click on the time in the **Clip TC Offset** column for the clip and enter the point in the clip at which you want it to start. This is an offset from the in point of the clip. For example, if you want the clip to start playing 5 seconds into the clip, enter `00,00,05,00`.

7. Repeat these steps for every clip in the TC Chase List.

8. Click **Save**.

To **Air a TC Chase List**

Take the TC Chase List on-air to play each clip in order at the specified timecode values.

**Note:** A TC Chase List has no mix transition and only uses a single channel transport.

1. Double-click on the TC Chase List you want to air in the Clip Library.
2. Select the channel transport that you want to play the TC Chase List on.
3. Click **START TC Chase** on the **TC Chase Editor** window.

The **TC Chase Editor** window changes to the **TC Chase ON-AIR** window. As the timecode reaches the point for each clip, the clip is highlighted red and plays out on the channel transport. The channel transport outputs black if no clip is scheduled to play during the current timecode.
Replay Overview

The Mira Express can operate as a replay server with the addition of the Mira Control Surface which allows quick interaction with the replay interface.

Required Equipment

To set up and operate your server you will need a computer monitor supporting either VGA (analog) or DVI-D (dual-link). A monitor with a minimum native resolution of 1920×1080 is recommended for best user experience. A computer monitor is not supplied by Ross Video.

A standard USB keyboard (QWERTY) and mouse are provided with your server.

Control Surface

The Control Surface has been designed to give you quick access to all the functions of the replay operation without the need for a keyboard or mouse.
There is no power switch on the Control Surface. When you connect the Control Surface to the Control Surface port on the server the panel boots up. When the unit is up and running the softkey buttons along the top will illuminate, in order, from 1 to 10.

**Note:** If the softkey buttons do not illuminate, or the sequence appears frozen, disconnect and reconnect the ethernet cable to the Control Surface. If the problem persists, please contact technical support.

**Softkey Buttons and Shift**

Press the 1 through 10 buttons along the top of the Control Surface to select cameras, navigate menus, or make selections. The corresponding assigned function of each softkey button is shown along the bottom of the Replay window. The label on the far left corresponds to softkey button 1 and the button on the far right corresponds to softkey button 10.

Press the SHIFT button to access the shifted function for all the buttons on the Control Surface. The buttons and indicators will pulse yellow while shift is active. The shifted function for a button is shown just above the button. When you press a button, or press the SHIFT button again, the Control Surface returns to normal.

**Tip:** Press and hold the SHIFT button for 3 seconds to enable shift-lock. The Control Surface will remain in shift mode until the SHIFT button is pressed again.
T-Bar Area

- **T-Bar** – allows you to manually set the play speed of the clip playing out on the program channel transport. In default mode the range is from 0% play-speed at the bottom (towards you) and 100% play-speed at the top (away from you). Video starts to play as soon as the T-bar is moved.

  **Tip:** The T-bar can be locked to a specific playout channel by holding the VAR PLAY button and pressing the P button for the playout channel you want to assign the T-bar to. Even if another playout channel has focus, the T-bar will still control the playout channel it is assigned to. Press the buttons again to release the lock.

- **VAR2/VAR3** – allow you to use different playout speeds from the User Setup menu.
- **DISABLE** – press and hold DISABLE to disable to playout functionality of the T-bar. This can be used to disable the playout function of the T-bar while you select a playout speed.
- **REVERSE** – press and hold REVERSE to reverse the direction of playout.
- **VAR PLAY** – press VAR PLAY play the clip at the selected playout speed. The playout speed is shown at the bottom right of the Replay window.

Clip Control Area

- **SEARCH** – use the keyboard to enter the name of a clip you want to find and press SEARCH. Press EXIT to return to normal operation.
- **NETWORK** – press SHIFT > SEARCH to open the Select Event menu. This list shows all the replay events on the server.
- **LOAD** – press LOAD to load the selected clip in the Clip Register. The selected playout channel goes into Clip Play mode.
- **BANK#** – use the keyboard to enter the number of the Clip Register bank you want to use and press SHIFT > LOAD.
- **SAVE** – store the current live recording to a clip or save the new in-point, out-point, and point of interest (POI) to the clip for the current camera.
- **TRIM ALL** – press SHIFT > SAVE to save the new in-point, out-point, and point of interest (POI) to the clip for all the cameras.
- **ERASE** – press ERASE to erase the current clip.
• **RESTORE** – press **SHIFT > ERASE** to undo the last erase.
• **GOTO IN** – press **GOTO IN** to jump to the in-point of the clip.

Tip: press **GOTO IN** during **LIVE EE** mode to mark a point of interest and rewind by the Auto-mark In-point offset

• **GOTO POI** – press **GOTO POI** to jump to the point of interest of the clip.
• **GOTO OUT** – press **GOTO OUT** to jump to the out-point of the clip.
• **PRE-ROLL** – press **SHIFT > GOTO IN, GOTO POI, GOTO OUT** to jump to the start of the pre-roll interval for the selected point.
• **IN** – press **IN** to set a new in-point for the clip. The button glows red when the clip is at the in-point.
• **POI** – press **POI** to set a new point of interest for the clip. The button glows red when the clip is at the point of interest.
• **OUT** – press **OUT** to set a new out-point for the clip. The button glows red when the clip is at the out-point.

**Navigate Area**

• **EXIT** – press **EXIT** to exit the current mode. The indicator below the button pulses when the **EXIT** button can be used.
• **HI-LITE** – press **SHIFT > EXIT** to switch between the Clip Register window and the Play List window.
• **▲** – press **▲** to move up one row in a menu or list.
• **PAGE UP** – press **SHIFT + ▲** to move up one page in a menu or list.
• **▼** – press **▼** to move down one row in a menu or list.
• **PAGE DOWN** – press **SHIFT + ▼** to move down one page in a menu or list.

**Live EE Area**

• ● – press ● to put the playout channel in **LIVE-EE** mode. The output of the channel is the same as the input.
Play List Area

- **PLAY LIST** — press **PLAY LIST** to put the selected playout channel in Play List mode. The button flashes in **PL EDIT** (Play List edit mode) and is solid **PLAY LIST** mode.

  *Tip: In **PL EDIT** mode, press **PLAY LIST** to go to **PLAY LIST** mode and press the button again to jump to the first clip in the current Play List.*

- **APPEND** — press **APPEND** to add the selected clip to the end of the current Play List.
- **INSERT** — press **SHIFT > APPEND** to add the selected clip to the end of the current Play List.
- **CUT** — press **CUT** to cut the selected clip in the Play List. You can paste the clip to a new location, or use this as a way to delete a clip from the list.
- **DELETE LIST** — press **SHIFT > CUT** to delete all the clips in the current Play List.
- **COPY** — press **COPY** to copy the select clip in the Play List. You can paste the clip to a new location, or use this as a way to delete a clip from the list.
- **PASTE** — press **PASTE** to paste a clip from the clipboard to the position just below the selected clip in the Play List.
- **TAKE** — press **TAKE** to cut to the selected clip in the Play List. Take can be used if a clip starts or ends on a pause, or if you want to move to a different clip in the list.

Output Control Area

- **P1** – press **P1** to select playout channel 1.
- **P2** – press **P2** to select playout channel 2.
- **P3** – not used.
- **P4** – not used.
- **GANGE** – press **GANG** to select all playout channels.
Rotary Dial Area

- **Rotary Dial** – allows you to perform a variety of functions, depending on the selection to the left of the dial. By default, the rotary dial is used to jog through the video loaded in the channel transport.
- **MARK** – press **MARK** to insert a point of interest (POI) mark at the current timecode across all camera inputs. The playout is not interrupted, but the mark is recorded in the **VUE MARKS** list. In and Out-points are automatically created based on the Auto-MARK In and Out offsets from the **User Setup** menu.
- **VUE MARKS** – press **SHIFT > MARK** to view the current list of marks
- **SCROLL** – press **SCROLL** to be able to use the rotary dial to move up and down in a list.
- **BROWSE** – press **SHIFT > SCROLL** to have a clip automatically loaded when it is highlighted.
- **WINDOW** –
  - **MIN/MAX** – press **SHIFT > WINDOW** to hide the row of camera inputs on the **Replay** window. Press the buttons again to revert to the default layout.
- **CRUISE** – press **CRUISE** to use the rotary dial to move backwards or forwards through a clip. As you turn the dial you set the speed that you move through the clip. The further you turn the dial, the faster you move through the clip. When you stop rotating the dial the clip keeps going at the set speed.
- **FAST CRUISE** – press **SHIFT > CRUISE** to cruise through the clip at a faster speed. The speed is set from the **User Setup** menu.
- **JOG** – use the rotary dial to move forwards or backwards through a clip. As you turn the dial you move through the clip. The faster you turn the dial, the faster you move through the clip. When you stop rotating the dial the clip stops.
- **FAST JOG** – press **SHIFT > JOG** to jog through the clip at a faster speed. The speed is set from the **User Setup** menu.
- **User Setup Menu** – press the **MARK** and **SCROLL** buttons simultaneously to open the **User Setup** menu.
- **Panel Lock** – press the **CRUISE** and **JOG** buttons simultaneously to lock the Control Surface. The **CRUISE** and **JOG** buttons flash red and server does not respond to any other button, T-bar, or rotary dial input. Press the buttons again to unlock the Control Surface.
Play Back Area

- **상우** – press and hold rewind the clip, or press and release to jump a small interval.
- **STEP** – press **SHIFT** and **STEP** to reverse by a single field.
- **PAUSE** – pause the playout of the current clip.
- **▼▼** – press and hold to fast forward the clip, or press and release to jump a small interval.
- **STEP** – press **SHIFT** and **STEP** to advance by a single field.
- **GOTO TC** – quickly jump to a timecode position in a clip. Use the keyboard to enter the timecode in the **ENTRY** field (HOUR:MIN:SEC:FRAMES) and press **GOTO TC**.
- **GOTO ITEM** – quickly jump to an item in a numbered list (e.g. Play List or Vue Marks lists). Select the list, use the keyboard to enter the number of the list item you want to jump to in the **ENTRY** field, and press **SHIFT + GOTO TC**.
- **◀** – play the clip in reverse. The speed of play can be adjusted using the **VAR 2/3** settings and the T-bar.
- **■** – stop the current transport action.
- **▶** – play the clip forward. The speed of play can be adjusted using the **VAR 2/3** settings and the T-bar.
- **LOOP** – loop the playback of the current clip in **PLAYBACK** and **CLIP PLAY** modes. Looping will go between the in-point and out-point of the clip. Press **LOOP** to toggle loop play on or off. The 🎥 icon is shown at the top of the playout channel border to indicate that loop mode is active and the **LOOP** button pulses green.
- **LIST LOOP** – press **SHIFT > LOOP** to have the entire Play List loop to the start of the first clip when it reaches the end of the last clip. The 🎥 icon is shown at the top right in the Play List to indicate that list loop mode is active and the **LOOP** button pulses amber.

**Tip:** If both Loop and List Loop are active the button pulses green and then amber.

Replay Window

The **Replay** window allows you to quickly view all the playout channels and camera inputs for the server, as well as access Clip Registers, Play Lists, and menu items.
The playout channels are shown at the top of the window as the program outputs. The name that appears on each playout channel can be set from the user settings. You can select each playout channel using the P1, P2, P3, P4 buttons on the Control Surface, or the GANG button to select them all. Each playout channel has a custom color to help you identify it quickly. This color is applied to the entire border when a playout channel is selected, and only in a thin line around the image when the playout channel isn’t selected.

The playout mode, timecode, and playback speed are all shown along the top of the box.

Camera Inputs
Below the playout channels are the camera inputs. This is the live feed that is coming in from each camera at the event. Each camera input can be selected by pressing the corresponding softkey along the top of the Control Surface.

The camera inputs are tallied with the color of the playout channel they are selected on. In the example above, **CAMERA 1** is selected on the **PGM-1** playout channel. The **PGM-1** playout channel has been assigned the orange color in the user setting and so the box around the **CAMERA 1** camera input is also orange.

### Lists and Menu

Below the camera inputs are the Clip Register list and the Play List/Menu interface. When one region is active, the other region is dimmed. The amount of dimming is set in the user settings.

### Softkeys

The softkey labels are shown at the bottom of the window and correspond to the numbered buttons along the top of the Control Surface. To make a selection you can either click a softkey directly, or press the corresponding softkey button on the Control Surface. In the example above, click **Mira Clip Library** or softkey **7** to select camera 1. This is often written as **Mira Clip Library (7)** in the documentation.

### Modes of Operation

Each playout channel can be in different modes depending on what the action you are performing. The mode that a playout channel is operating in is shown at the top of the playout channel box next to the channel name.

#### Live EE Mode

In Live EE mode (Electronic to Electronic) the video fed out of the playout channel is the same as the selected camera source and is showing the live record point. The live record point is the point in the feed where the camera video is being recorded to the replay record train.
**Playback Mode**

In Playback mode you can replay a clip of an event that just took place. The clip is played on the selected playout channel.

*Note:* You must define and save the clip to the Clip Register for it to be available for playout at another time.

**Clip Play Mode**

The Clip Play mode allows you to view any local clip on the server that is being played out one of the playout channels. These server clips can be played, added to a Play List, or saved and trimmed to Bank 0.

Bank 0 is used to save server clips (Clip Library clips) so they can be trimmed and edited and made available in the replay modes.
Play List Mode

The Play List mode allows you collect and arrange clips into a list that can be taken on-air.

Note: Selecting a camera with the softkeys is not available when the server is in Play List mode.

Vue Mark Mode

The Vue Mark mode allows you to view a list of marks made in the current replay event. Mark points show timecode, camera, and a name (if applied).
Replay Events

A replay event puts the server into replay operation. The incoming video signals from the cameras are continuously being recorded for use in a replay. When an event you want to replay occurs, you can seek to the start of the action that you want to replay and play it out of one of the playout channels.

To Create/Edit a Replay Event

A replay event puts the server into replay mode and optimizes the interface for a replay

**Note:** The server must be configured into the ISO mode you want to use for your replay setup and any Control Surfaces must be connected to the server and assigned to playout channels before you can create a replay event.

**Tip:** If you have already created a replay event, you can right-click on the file in the Clip Library and click [Modify Replay Event](#).

1. In **Mira Explorer**, click on the ISO record channels to confirm the input video from the cameras.
2. Click **New > New Replay Event**.
3. In the **Replay Event Name** field, enter a name for the replay event.

4. On the **Record Channel** list, select the channel transport that you want to use for the multi-channel ISO clip.
   
   **Note:** The ISO mode records multiple video streams into a single clip and uses a single channel transport. Depending on the ISO mode, this can be **REC 1-4**.

5. Click **Next**.
6. Do you have a User Setup file for your Control Surface that you would like to use?
   - **Yes** – click [Select Mira Control Surface User Setup](#), navigate to the file, and click **Open**.
   - **No** – proceed to the next step.

7. Click **Next**
8. Do you have a Replay Event Template that you would like to use?
   - **Yes** – click [Select Replay Event Template](#), navigate to the file, and click **Open**.
   - **No** – proceed to the next step.

   **Tip:** If any clips included in a playlist in the template have been moved or deleted they will be listed as missing. Click [Select Path to Locate Missing Clips](#), navigate to the new location for the clips and click **Select Folder**. If you want to save this new location for the clips select [Save New Paths back to original Replay Event Template](#).

9. Click **Next**
10. In the **Camera Name** field, enter a name for each camera feed.
11. On the **Camera Number** list, select the number you want to assign to each camera feed.
12. Click **Next**.
13. You can apply preset names to replay clips from the Control Surface using the sofkeys. Set the names you would like to use as follows:

   a) In the **Initial Name** column, enter a prefix you want be able to apply to a clip name using the 8, 9, or 10 sofkeys on the Control Surface.

   b) In the **SK 1** through **SK 10** columns, enter a shifted (Shift + SK X) and unshifted (SK X) name. The shifted and unshifted names allow you to be able to apply two different names from the same softkey.

14. Click **Create Event**.

   The replay event has been created in the Clip Library.
15. Click **Start RECORDING**.
   The replay event is now recording in the channel transport.

16. Click **Finish**.
   The recording channel shows it is recording the camera inputs.

With the event created and recording, you can now open the event on the Control Surface to launch the replay operation interface.

**To Open a Replay Event on a Control Surface**

Open a replay event on a Control Surface to activate the replay interface.
In the Clip Library, right click on the replay event you want to open and click **Open on Control Panel**.
The **Replay Event** window opens.
To Open an Existing Replay Event from a Control Surface

You can open an existing replay event from within a replay event to copy clips from another replay event to the current one.

1. Press **SHIFT > SEARCH**.
   
   The **Select Event** list is shown. Replay events on the server, and any network connected servers, are shown on the list.

   ![Select Event List](image)

2. Select the replay event you want to load and press **LOAD**.
   
   **Tip:** Select a replay event and press **Set Favorite (3)** and select a softkey for the number you want to apply to the favorite. This allows you to quickly load that replay event at any time using the keyboard. For example, if you assign a replay event for favorite 3, you can quickly switch to that replay event by pressing **Ctrl+3** on the keyboard. Press **EXIT (10)** to return to original replay event.

   The event opens in a new tab that allows you to select and append cameras to the Play List.

   **Note:**Appending a clip from a network server does not copy the clip to the server. The clip is only available as long as the remote server is connected.

To Create/Edit a Replay Event Template

Replay event templates save camera names and numbers, clip naming preset softkeys, clip pointers, and clips that have been placed in the playlist for the replay event.

1. In the Clip Library, right-click on the replay event that you want to save as a template and click **Save as Replay Event Template**.

2. In the **TemplateName** field, enter a name for the template and click **Next**.
   
   **Tip:** Select an already existing template to overwrite it with the new template settings.

3. Select the playlists that you want to include with the template.

   Any server clips in the playlist that is included in the template are assigned to the same playlist in the new replay event created from the template. For example, clips of player headshots are on a playlist called Players that is included in template. When that template is applied to a replay event the Players playlist with the clips appears in the event.

4. Click **Create Template > Finish**.
Replay Operation

The replay operation uses a replay event that is opened on a Control Surface. The replay event requires channels on the server to be set to replay (ISO), and the Control Surface to be assigned to playout channels. A typical replay workflow involves importing clips you want use during the replay, capturing events, replaying them immediately or storing them for later, and export for archive or later use.

Loading Server Clips

It is important to load any clips you want to use into the replay event. This allows you to quickly add them to a Play List or use them during a live replay.

To Import a Clip from the Clip Library

You can load server clips into a replay event where they can be trimmed, edited, cued, and saved to the Clip Register (Bank 0).

1. Select the playout channel that you want to load the clip into.
2. Press Mira Clip Library (SHIFT+10).
   
   Tip: Only clips that are local and in the same video format that the server is operating in (cueable) are shown on the list.

   The Clip Library is shown at the bottom of the window.

3. Select the clip that you want to use in the replay event. By default, the clip is loaded into the playout channel as soon as it is selected.
   
   Tip: Press APPEND to Play List (7) or INSERT in Play List (6) to add the selected clip to the current Play List. Append will add the clip to the end of the list and Insert will add the clip to the list before the currently selected clip.

4. Press SAVE to save the clip to Bank 0 in the Clip Register.
5. Press EXIT to exit the Clip Library.

Capture a Replay Event

The replay operation has a number of parts, depending on how you want to replay clips and whether you want to store those replay clips for later.

To Put a Playout Channel in Live Record (EE) Mode

Live record, or EE, mode takes the live camera feeds coming into the server and sends it out the selected playout channel. The video coming out the playout channel is the same as what is being recorded in the replay event.
1. Press the \textbf{PX} button for the playout channel you want to send the live record video out of.

\textbf{Tip:} You can press \textbf{GANG} to assign the Control Surface to all the playout channels (the borders around all the playout channels turn white). Only the active playout channel with the red arrows at the top will accept camera selections. Press \textbf{●} to send all the selected cameras to the record train for all playout channels.

The border around the selected playout channel turns a solid color and two red arrows appear at the top to indicate that the Control Surface is assigned to that playout channel.

2. Press \textbf{Live EE (●)}.

A red \textbf{LIVE EE} is shown at the top corner of the border around the playout channel.

3. Press the softkey for the camera you want to view.

\textbf{Tip:} If the Video Router Control is active, you can change the router source that is routed to each camera input on the server. Press Ctrl + the softkey for the camera that you want to change the source for to show the \textbf{Router Source List}. Select the new source and press \textbf{Load} (or \textbf{Select Source (4)}). If you know the name of the source you can enter it using the keyboard and press \textbf{SEARCH} to locate it.

The video from the selected camera is shown on the selected playout channel and the border around the camera video and softkey button changes to the same color as the playout channel border.

\begin{center}
\includegraphics[width=\textwidth]{image1.png}
\end{center}

\textbf{To Capture an Event for Live Replay}

You can replay a clip instantly from a live recording. A playout channel must be in \textbf{Live EE} recording mode to be able to replay an event.

\begin{enumerate}
\item Put the playout channels you want to use for a replay event in Live Record mode. Refer to \textit{To Put a Playout Channel in Live Record (EE) Mode} on page 94 for information on live record mode.
\item Mark the clip when something interesting happens. You can either mark the point of interest (POI), end of the event (end-point), or start of the event (in-point). The remaining points are automatically marked according to the Auto-Mark In/Out point from the \textbf{User Setup} menu.
\begin{itemize}
\item \textbf{Point of Interest} — press \textbf{POI} to mark a POI at the current timecode for all cameras. You can also press \textbf{SAVE} to store the event to the clip register.

\textbf{Tip:} If you know the timecode of the event you want to replay, you can enter the new timecode in the \textbf{ENTRY} field and press \textbf{GOTO TC} to jump to that timecode.

\item \textbf{Out-Point} — press \textbf{OUT} to mark the out-point (end) of the event for all cameras.

\textbf{Tip:} You can set the out point based on the live record when in Playback mode by holding  and pressing \textbf{OUT}. This marks the out point at the current timecode of the live record (not the playback video).

\item \textbf{In-Point} — press \textbf{IN} to mark the in-point (start) of the event for all cameras.
\end{itemize}
\end{enumerate}
Once an event is marked, you can play it back immediately using the GOTO buttons and the T-bar or VAR PLAY.

**Playback**

Once you have marked an event you can jump back to it and play it back immediately, as well as save it for later.

**To Playback an Event from Live Record**

You can playback any event that is marked from live record. Marking an event gives you a point to quickly jump back to so that you can edit and clip to a playlist.

1. Use the GOTO buttons to jump to the event you want to replay. The playout channel goes into Playback mode once you jump away from the live record point.
   - In-Point — press GOTO IN (the IN button turns red) and use the rotary dial to select the new point and press IN to mark it.
   - Point of Interest — press GOTO POI (the POI button turns red) and use the rotary dial to select the new point and press POI to mark it.
   - Out-Point — press GOTO OUT (the OUT button turns red) and use the rotary dial to select the new point and press OUT to mark it.

   **Tip:** You can also press ◀, ▶, ◄, or ▸ buttons to fine-tune the points.

2. Play the clip back at the desired speed.
   - Normal Speed — press ▶ to play the clip at normal speed.
   - T-Bar — move the T-bar to play the clip at a dynamic variable speed. The further you move the T-bar, the faster the clip plays. You can set the play speed of either limit from the User Setup menu.

     **Tip:** If the T-bar is at 100% but you want to start from 0%, press and hold DISABLE and move the T-bar to the new location. Playout speed does not change when you move the T-bar while pressing the DISABLE button.

   - Variable Speed 1 — press and hold DISABLE and move the T-bar to the speed you want to play the clip at and release the button, or enter the speed manually with the keyboard. The speed is shown in the SPEED PRESET field at the bottom right of the menu. Press VAR PLAY to play the clip at the variable speed.
   - Variable Speed 2/3 — press VAR 2, or SHIFT + VAR 2 (variable speed 3) to set the speed and press VAR PLAY to play the clip.
Tip: Press LOOP to turn looping on and have the clip seek back to the in-point when it reaches the out-point. When looping is active the icon is shown at the top of the border around the playout channel.

You can name and save the clip to a playlist for future use. Refer to Clipping on page 97 for more information.

**Clipping**

Once you have marked and trimmed a clip you can name and save it to the Clip Register for future use or export.

**To Save a Clip to the Clip Register**

Capture and store a replay clip to the Clip Register for future use.

1. Mark the clip you want to save.
2. Use the keyboard to enter the number of the Bank (0-99) that you want to store the clip to in the ENTRY field and press SHIFT > LOAD.
3. Manually adjust the in-point and out-point as required.
   - **In-Point** — press GOTO IN (the IN button turns red and the playout channel goes into PLAYBACK mode) and use the rotary dial to select the new point and press IN to mark it.
   - **Out-Point** — press GOTO OUT (the OUT button turns red and the playout channel goes into PLAYBACK mode) and use the rotary dial to select the new point and press OUT to mark it.

   Tip: You can also press \<ül, \<uers, \<, \<, or \< buttons to fine-tune the points.

   Tip: You can use the softkeys on the Control Surface to select a different camera angle.

4. Press SAVE to save the clip with all the camera angles to the Clip Register.
5. Press LOAD to load the clip.

The playout channel goes into CLIP PLAY mode and the in-point of the new clip is shown. The IN button lights red to indicate that you are looking at the in-point of the new clip.

**To Name a Clip**

Once a clip has been defined and saved you can name the cameras in the clip to organise them for future use. A name can be applied to a single camera or all the cameras in the clip.

The preset names are set from the User Setup menu. Ensure that you have saved the text you want to use before trying to name a clip with preset names.
1. Use the keyboard to enter the number of the Bank (0-99) that you want to store the clip to in the **ENTRY** field and press **SHIFT > LOAD (BANK #)**.

2. In the Clip Register select the clip and camera.

3. Enter a custom name or use one of the preset names.
   - **Custom** — use the keyboard to enter the new name in the **ENTRY** field.
   - **Preset** — press the 8, 9, or 10 softkeys to apply text to the camera name. Additional text can be added to the name by pressing one of the 1-9 softkeys or using the keyboard.

4. Apply the name to a single camera, or all cameras in the clip.
   - **Single** — press **Enter** on the keyboard.
   - **All** — press **Shift + Enter** on the keyboard.

**To Load a Clip from the Clip Register**

Once a clip is captured, you can load the clip and camera to a playout channel.

1. Select the playout channel that you want to load the clip into.

   **Tip:** If you know the bank, clip number, and camera number you can jump to the clip directly. Use the keyboard to enter the clip number in the **ENTRY** field and press **LOAD**. The number should take the form **bankclip-camera**. For example, 1207-2 loads camera 2 of clip 07 from bank 12. Similarly, 405 loads clip 05 from bank 4 using the currently selected camera, and 37-1 loads camera 1 of clip 37 on the current bank.

2. Use the keyboard to enter the number of the Bank (1-99) that you want to load the clip from in the **ENTRY** field and press **SHIFT + LOAD**.
   
   **Note:** Bank 0 is intended for Clip Library (server clips) that you want to make available for replay actions.

3. Press **LOAD** and from the Clip Register list select the clip (▲ / ▼) and camera (softkeys) that you want to load. By default, the clip is automatically loaded when it is selected. The arrow buttons on the keyboard can also be used to navigate the list.

The playout channel goes into **CLIP PLAY** mode and the in-point of the new clip is shown. The **IN** button lights red to indicate that you are looking at the in-point of the new clip.
To Trim a Clip
You can adjust the position of the in-point, out-point, and POI in the clip for all cameras, or just a single camera.

1. Load the clip that you want to trim.
2. Select a new in-point as follows:
   a) Press GOTO IN.
   b) Use the rotary dial to select the new in-point.
   c) Press IN.
3. Select a new point of interest as follows:
   a) Press GOTO POI.
   b) Use the rotary dial to select the new point of interest.
   c) Press POI.
4. Select a new out-point as follows:
   a) Press GOTO OUT.
   b) Use the rotary dial to select the new out-point.
   c) Press OUT.
5. Save the new points to the clip for all cameras or only the selected camera.

Tip: You don't have to save the new trim points if you are in PL EDIT or VUE MARKS mode.

- **All Cameras** — press SHIFT + SAVE.
- **Selected Camera** — press SAVE.

Play List
The Play List operation focuses on ordering and editing clips to be taken on-air in order and as a group, as a highlight reel for example.

To Create a Play List
Replay clips can be collected together into a Play List that can be taken on-air.

1. Use the keypad on the keyboard to enter the number of the Play List you want to create or edit and press PLAYLIST.

2. Select the clip and camera in the Clip Register that you want to add to the Play List.

Tip: Press SHIFT > PLAY LIST to view the Play List Library. Press LOAD PLAY LIST (1) to load the selected Play List.

Tip: Press SHIFT > MARK and select a mark point that you want to add to the Play List instead of a clip.

Tip: Press LOAD to load the clip into the selected playout channel if you want to preview the clip.
3. Add one or all cameras to the end (Append) of the Play List.
   - **All Cameras** — press and hold **APPEND** to add all the cameras in the clip to the end of the Play List.
   - **Selected Camera** — press **APPEND** to add the selected camera to the end of the Play List.

4. Add one or all cameras to a point (Insert) in the Play List.
   - **All Cameras** — select the item in the Play List that you want to insert the cameras above and press and hold **SHIFT** + **APPEND**.
   - **Selected Camera** — select the item in the Play List that you want to insert the camera above and press **SHIFT** + **APPEND**.

   **Tip:** Press **SHIFT** + **EXIT** to switch between the Play List and the Clip Register.

   **Tip:** To change the name of a clip in the Play List, select the clip and use the keyboard to enter a new name in the **ENTRY** field and press **Enter**. The new name only applies to the item in the Play List.

   **Tip:** You can change the camera that is shown in the clip by selecting a different camera (softkeys).

5. Trim the in-point, POI, and out-point of the clip on the Play List as required using the buttons in the **CLIP CONTROL** area.

### To Name a Play List

Each Play List can have a unique name to help you identify it. Names can also be copied and pasted from Play List to Play List.

1. Press **PLAY LIST > Edit Item Flags (10) > PLAY LIST Library (1)**.

2. Select the Play List that you want to name.

3. Use the keyboard to enter a new name in the **ENTRY** field.

4. Press **NAME PLAY LIST (2)**.

   **Tip:** You can copy (**COPY PL NAME (4)**) and paste (**PASTE PL NAME (5)**) names from one Play List to another, or clear (**CLEAR PL NAME (3)**) the current name.

### To Edit a Play List

The Play List can be edited in a replay event in much the same way as it is in server mode.

1. Press **PLAY LIST > Edit Item Flags (10) > PLAY LIST Library (1)**.

2. Select the Play List that you want to edit and press **LOAD PLAY LIST (1)**.

   **Note:** Press **SHIFT > CUT** to delete all items in the current Play List. There is no undo to this function.

3. Press **Edit Item Flags**.

4. Select the item in the Play List that you want to edit.
5. Adjust the playout speed or runtime of the clip as required.
   - **Speed** — use the keyboard to enter a new playout speed (100 = real time, 200 = 2×real time) in the **ENTRY** field and press **SPEED (4)**.
   - **Runtime** — use the keyboard to enter a new clip length (2500=25:00 seconds, 915=9 seconds 15 frames) in the **ENTRY** field and press **RUNTIME (9)**.

6. Select the type of transition you want to use to go to the next clip in the Play List. They current transition
   - **Dissolve** — press **TRANS (5)** to toggle to **MIX** in the Play List table.
   - **Cut** — press **TRANS (5)** to toggle to **MIX** in the Play List table.

7. Adjust the dissolve rate (mix duration) if required.
   - Use the keyboard to enter a new duration for the transition in the **ENTRY** field and press **MIX DUR (6)**.

   **Important:** The Play List must be using two playout channels to be able to perform a dissolve (mix) transition between clips.

8. Set a different behaviour for the start (@START) of a clip if required.
   - **Play** — press **@START (7)** to toggle to **PLAY** in the Play List table. The clip plays out automatically when the playlist transitions to this clip in ON-AIR mode. This is the default setting.
   - **Pause** — press **@START (7)** to toggle to **PAUSE** in the Play List table. The clip is paused on the first frame when the Play List transitions to this clip.

9. Set a different behaviour for the end (@END) of a clip if required.
   - **Take** — press **@END (8)** to toggle to **TAKE** in the Play List table. The Play List transitions to the next clip.
   - **Pause** — press **@END (8)** to toggle to **PAUSE** in the Play List table. The clip is paused on the last frame when it reaches the end of the clip. You must press **TAKE** to transition to the next clip.
   - **Loop** — press **@END (8)** to toggle to **LOOP** in the Play List table. The clip is looped when it reaches the end. You must click **TAKE** to transition to the next clip immediately or toggle **LOOP** off in the **PLAY BACK** area.
   - **Play** — press **@END (8)** to toggle to **PLAY** in the Play List table. The out-point of the clip is ignored and the clip will continue playing until it is stopped or reaches the end. You must click **TAKE** to transition to the next clip immediately.

   **Note:** The Play List will ignore the @END command while the loop (_repeat) flag is set. You must either toggle **LOOP** off to proceed to the @END of the clip, or press **TAKE** to transition to the next clip in the Play List.

**To Copy and Paste Play List Items**
An item can be cut or copied from one Play List and pasted into another. Deleted items can also be copied from the Trash Can and copied and pasted back into a Play List.

1. Press **PLAY LIST > Edit Item Flags (10) > PLAY LIST Library (1)**.
2. Select the Play List that you want to copy an item from and press **LOAD PLAY LIST** (1).

   *Tip: The Trash Can item at the bottom of the list stores deleted (cut) clips.*

3. Select the item that you want to copy.

4. Press **CUT** (7) or **COPY** (8) to put the item onto the clipboard.

   *Tip: If you want to copy and paste items within the same Play List you can skip to the last step and paste the item in the new position within the same list.*

5. Press **Edit Item Flags** (10) > **PLAY LIST Library** (1).
6. Select the Play List that you want to paste the item to and press **LOAD PLAY LIST** (1).
7. Select where in the Play List you want to paste the item.
   - **Paste Before** — select the item you want to paste the new item before and press **SHIFT > PASTE** (9).
   - **Paste After** — select the item you want to paste the new item after and press **PASTE** (9).

**To Enable Aux Audio for a Play List**

You can create an aux audio list that overwrites the clip audio and plays simultaneously with the clips as the Play List is aired.

   *Note: Aux Audio will always play at 100% speed, even if the video is playing at a different speed.*

1. Press **PLAY LIST > SHIFT > AUDIO CONTROL** (10).
   The playout channel goes into **PL EDIT** mode.

2. Press **AUX AUDIO ENABLE** (5) to toggle the feature on.
3. Press **Mira Clip Library (3)** and select the audio clip that you want to add to the Aux Audio list.
4. Add the audio clip to the end (Append) of the Aux Audio list.
   - Press **APPEND to AUX Audio (9)** to add the selected audio clip to the end of the Aux Audio list.
5. Add the audio clip to a point (Insert) in the Aux Audio list.
   - Select the item in the Aux Audio list that you want to insert the audio clip above and press **INSERT in AUX Audio (8)**.

*Tip:* Press **SHIFT > EXIT** to switch between the Play List and the Clip Register.

### To Air a Play List

You can take a finished Play List on-air with one or two playout channels. They server will play through the clips in the list according to the Play List. Transitions between clips require two playout channels.

*Note:* If the **ALWAYS use PVW/PGM pair in PLAY LIST AIR** setting from the **User Setup** menu is set to **ON**, you will always use two playout channels for Play List playout control. If the option is set to **OFF**, you can manually select one or two channels for Play List playout control.

1. If playout channel 1 is in Play List mode, press **P1 > .** You cannot gang channels together from Play List mode.
2. Select number of playout channel(s) that you want to take the Play List on-air with.
   - **1-Channel** — press **P1 > PLAY LIST**.
   - **2-Channel** — press **GANG > PLAY LIST**.
3. Press **Edit Item Flags (10) > PLAY LIST Library (1)**.
4. Select the Play List that you want to play and press **PLAY LIST**. The Play List is loaded and the playout channel is in **PL EDIT** mode.

5. Press **PLAY LIST** again.

The playout channels are in **PLAY LIST** mode. In 2-channel playout you will notice that the first item in the Play List is cued in P1 and the second item in the list is cued in P2.
6. Play the clip at the desired speed.
   - **Normal Speed** — press ▲ to play the clip at the speed set in the Play List.
   - **T-Bar** — move the T-bar to play the clip at a dynamic variable speed. The further you move the T-bar, the faster the clip plays. You can set the play speed of either limit from the User Setup menu.
   - **Variable Speed 1** — press and hold DISABLE and move the T-bar to the speed you want to play the clip at and release the button, or enter the speed manually with the keyboard. The speed is shown in the SPEED PRESET field at the bottom right of the menu. Press VAR PLAY to play the clip at the variable speed.
   - **Variable Speed 2/3** — press VAR 2, or SHIFT+VAR 2 (variable speed 3) to set the speed and press VAR PLAY to play the clip.

   **Tip:** If you need to skip a clip, or play a clip over again, you can use the ▲ and ▼ to select which clip is taken next on the Play List.

7. Press EXIT to exit PLAY LIST mode and return to PL EDIT mode.

### Export/Melt

Content from a replay event can be saved and exported (melted) to a standard clip format that can be archived and played in normal server operation. Each Play List, or clip, included in the melt is exported to a separate media file.

The replay event export/melt uses the same export method and destination folder as the export function of the server.

#### To Export/Melt a Play List

Melt replay clips from a Play List to a standard server clip.

**Tip:** If you want to export/melt a clip from a single camera, press SHIFT and then the softkey for the camera you want to export. This works in any operational mode where the softkey buttons are assigned to cameras.

**Tip:** You can export/melt the clips from the Play Lists in a replay event from the Clip Library in Mira Explorer. Right-click on the replay event you want to export the Play List from and click Melt Replay Event. Select the Play List(s) you want to export and click Finish. Refer to To Export Media Files on page 110 for more information.

1. Press PLAY LIST > Edit Item Flags (10) > PLAY LIST Library (1).

2. Select the Play List that you want to export and press LOAD PLAY LIST (1).

3. Press Edit Item Flags.
4. Press **SHIFT > MELT PLAY LIST (2)**.

5. Press the softkey for the export destination you want to use.

   **Note:** A yellow error message is shown if there is a problem exporting a clip. Check the export destination settings.

Each clip entry turns green and (^) is shown next to the **Clip ID** as it is exported. The green highlight indicates that the clip has been exported. A green clip entry will not be exported again unless the clip is changed or the melt flag is reset. When a clip is changed the entry returns to normal and will need to be exported again. This allows you to create a master melt where only the new or altered clips are exported.

**Tip:** Press **SHIFT > RESET ALL MELT FLAGS (10)** to clear the green highlights from all the clips. All the clips can now be exported again.
Mark

You can quickly create a mark point of the active camera to mark an event that you can come back to later. Creating the mark point automatically creates a point of interest (POI), in-point, and out-point based on the Auto-Mark IN/OUT setting of the User Setup.

You can only create up to 999 mark points in a replay event.

To Create a Mark Point

You can create a mark point during any operational mode. The timecode for that point is saved to the Vue Marks list, and you can continue with your current operation. Creating a mark point does not disrupt the current operation of the server.

When something interesting happens on one of the cameras, press MARK in the ROTARY DIAL area. A mark point is created at the timecode that the button was pressed.

To View and Edit Marks

Marks are stored in the VUE MARKS list and can be viewed and edited.

1. Press SHIFT > VUE MARKS.

The playout channel goes into VUE MARKS mode and the Vue Marks list is shown. Each mark has a timecode, camera, and duration.

2. Select the mark that you want to edit.

3. Use the softkeys to select a different camera if the event you marked was not captured on the default camera.

4. Select a new in-point as follows:
   a) Press GOTO IN.
   b) Use the rotary dial to select the new in-point.
   c) Press IN.
5. Select a new point of interest as follows:
   a) Press **GOTO POI**.
   b) Use the rotary dial to select the new point of interest.
   c) Press **POI**.

6. Select a new out-point as follows:
   a) Press **GOTO OUT**.
   b) Use the rotary dial to select the new out-point.
   c) Press **OUT**.

7. Press **SAVE** to store the mark point to the Clip Register.
Export

You can export a clip from the Clip Library to a number of formats for use in an external device. Files are exported in the same video format that the server is operating in.

Supported Media Files for Export

Table 2: Supported HD Video Codecs

<table>
<thead>
<tr>
<th>File Type</th>
<th>Codec</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOV</td>
<td>DV100</td>
<td>Panasonic® DV100 in Apple® QuickTime® MOV wrapper.</td>
</tr>
<tr>
<td>MXF</td>
<td>DV100</td>
<td>Panasonic® DV100 in MXF wrapper.</td>
</tr>
<tr>
<td>P2</td>
<td>DV100</td>
<td>Panasonic® DV100 in Panasonic® P2 wrapper.</td>
</tr>
<tr>
<td>CLIP</td>
<td>Native</td>
<td>native clip.</td>
</tr>
</tbody>
</table>

Table 3: Supported SD Video Codecs

<table>
<thead>
<tr>
<th>File Type</th>
<th>Codec</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOV</td>
<td>DV25</td>
<td>Panasonic® DV25 in Apple® QuickTime® MOV wrapper.</td>
</tr>
<tr>
<td></td>
<td>DV50</td>
<td>Panasonic® DV50 in Apple® QuickTime® MOV wrapper.</td>
</tr>
<tr>
<td>MXF</td>
<td>DV25</td>
<td>Panasonic® DV25 in MXF wrapper.</td>
</tr>
<tr>
<td></td>
<td>DV50</td>
<td>Panasonic® DV50 in MXF wrapper.</td>
</tr>
<tr>
<td></td>
<td>DV50</td>
<td>Panasonic® DV50 in Panasonic® P2 wrapper.</td>
</tr>
<tr>
<td>CLIP</td>
<td>Native</td>
<td>native clip.</td>
</tr>
</tbody>
</table>

To Select an Export Destination

You can set up to nine export destinations, each with a different export format. Destination folders should only be located on network drives or high-speed USB drives (USB 2.0/3.0/3.1) mounted on the server.

1. Click Configure > Export Configuration.

Important: Do not select an export destination on the system (C:) or media drive (H:) of the server. These drives are reserved for the operating system and media layout and recording. Exporting to either of these drives could cause video errors and system instability.
2. Click the Destination X tab for the destination you want to set up or edit.
3. Select Enable this destination to make this destination available for export. Destination 1 is always available for export.
4. In the Destination Name field, enter a new name for the destination tab.
5. Click Export Type and select the codec you want to use for the export.

   \textit{Note:} Only Abekas native \texttt{clip} and AVC-Intra \texttt{.mxf} are available when operating in a 1080p video format.

6. Click Change and select the network drive or USB folder that you want to export to.
7. Click Select Folder.
   The selected folder is shown in the Export directory field.
8. In the Media File Name Information area, select what information is included in the media file name.
9. In the Playlist Media File area, select how you want to melt the Play List (Replay only).
   \begin{itemize}
   \item Melt Playlist as One Media File — Play List is exported as a single file.
   \item Melt Playlist as Many Media Files — Play List is exported as multiple files.
   \end{itemize}
10. In the Melt Options area, select whether to add time to the head and tail of each clip in the Play List.
11. Select additional export destination as required.
12. Click Verify Export Destinations to verify that all destination can be found.
A message is shown next to the button stating that all destination are valid, or that destinations are missing. The destinations that are missing are highlighted in yellow.

13. Click OK.

**To Export Media Files**

Export media files from the server to another format that can be used by another device.

*Note:* Some export functions require a channel to export video. Ensure that the channel you want to use for exporting is not being used before you start the export.

1. Launch the **Mira Explorer** application.
2. Click **Clip Library**.
3. Select the clip(s) that you want to export in the Clip Library.

   *Tip:* To export/melt the clips from the Play Lists in a replay event, right-click on the replay event you want to export the Play List from and click **Melt Replay Event**. Select the Play List(s) you want to export and click **Finish**. The **Export Editor** opens with the clips from the selected Play List(s).

4. Click **Clip Library > Export**.

   The **Export Editor** opens with the selected clips listed.

5. To select a different destination for a clip, right-click on the clip and click **Set Destination**... and select the new destination.

6. To export a different camera angle from a replay event clip, right-click on the clip and click **Set angle**... and select which camera you want to export, or select **All Cams**.

7. To set a custom in-point and out-point, load the clip into the selected channel transport and use the transport controls to locate the new in-point or out-point and click **IN** or **OUT** to set that point. The timecode for the new in-point and out-point is shown in the table.

   *Tip:* To split the clip into segments, set the in-point to where you want the segment to end and click **Split Segment**. A new clip of the same name and export destination is created.

   *Tip:* To duplicate the segment, set the in-point and end-point to where you want to new clip to start and end and click **Duplicate Segments**. A new clip of the same name and export destination is created.

8. Select all the clips you want to export and click **Move to Export Queue**.

   The **Export Queue** opens with the selected clips listed.

9. Click **Start Export**.

10. If your export requires transcoding, in the **Channel to take offline** list, select the channel that you want to use for the export and click **OK**.

    The server starts exporting the clips to the destination folders.

   *Tip:* Click **Abort Export** to stop the export. The current clip is put back into the Export Queue with the remaining clips.
Remote Control Support

Use the information in this section to assist you in setting up an external device to control your server.

Remote Communications (RS-422)

Direct serial control of each channel transport on the server is available through the DB9 ports on the back of the server. Ethernet communications can also be used to control a channel transport instead of the direct serial connection.

*Note:* The BVW-75 and Odetics protocols are not supported over ethernet at this time.

The procedure for setting up a room for external control depends on the protocol you want to use.

To Configure a Room for the BVW-75 Protocol

Set up a Room to use the BVW-75 protocol to control server channels.

*Note:* The BVW-75 protocol does not support clip library listing or clip loading.

1. Launch the **Mira Config** application.
   
   You may be prompted to allow the program to make changes on the computer, click **Yes**.

2. Click the **RS422** tab.

3. Click **Room X Configuration** and select the room you want to configure. Later you will assign this room to a channel.

4. In the **RS422 Protocol** area, select **BVW-75**.

5. In the **Response Time** area, select how quickly the server executes the Clip Play command after the Clip Load command.
   
   - **Fast** — executes the play command immediately after the load command. This is recommended when controlling the server from an external switcher.
   
   - **Accurate** — executes the play command only after receiving confirmation that the clip has loaded. This is recommended when controlling the server from an automation system.
6. In the **Edit Timing** area, select a timing offset for when you are controlling the server from an external editor over serial.
   - **Timecode Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout or record.
   - **Source Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout.
   - **Out Point Offset** — select the offset, in fields, of the out-point timecode value that is sent to the editor during record.

7. In the **Video Edit Effect** area, select which tracks get recorded when an external editor issues the Video Record command to the server.
   - **Edit Video Track** — only the video track is recorded.

8. In the **BVW-75 Protocol Configuration** area, select specific configurations for the protocol you are using.
   - Select **Disable field timecode reporting** to force the server to report timecode only once every video frame. If this option is not selected, the server reports timecode every field.
   - Select the **Protocol ID** that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click on the **Ch-X:** list and select the room that you want to assign to the channel.
10. Click **Restart Mira**. A confirmation dialog box is displayed.
11. Click **Restart Mira** to restart the server application and services with the new setting.
12. Click **OK** when the restart has completed to dismiss the window.

**To Configure a Room for the Odetics Protocol**

Set up a Room to use the Odetics protocol to control server channels.

1. Launch the **Mira Config** application.
   - You may be prompted to allow the program to make changes on the computer, click **Yes**.
2. Click the **RS422** tab.
3. Click **Room X Configuration** and select the room you want to configure. Later you will assign this room to a channel.

4. In the **RS422 Protocol** area, select **Odetics**.

5. In the **Response Time** area, select how quickly the server executes the Clip Play command after the Clip Load command.
   - **Fast** — executes the play command immediately after the load command. This is recommended when controlling the server from an external switcher.
   - **Accurate** — executes the play command only after receiving confirmation that the clip has loaded. This is recommended when controlling the server from an automation system.

6. In the **Edit Timing** area, select a timing offset for when you are controlling the server from an external editor over serial.
   - **Timecode Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout or record.
   - **Source Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout.
   - **Out Point Offset** — select the offset, in fields, of the out-point timecode value that is sent to the editor during record.

7. In the **Video Edit Effect** area, select which tracks get recorded when an external editor issues the Video Record command to the server.
   - **Edit Video Track** — only the video track is recorded.

8. In the **Odetics Protocol Configuration** area, select specific configurations for the protocol you are using.
   - Select **Disable field timecode reporting** to force the server to report timecode only once every video frame. If this option is not selected, the server reports timecode every field.
   - Select the **Protocol ID** that you want to use (**Abekas 6000**, **Sony BVW-75**, or **Generic DDR**).

9. Click on the **Ch-X** list and select the room that you want to assign to the channel.

10. Click **Restart Mira**. A confirmation dialog box is displayed.

11. Click **Restart Mira** to restart the server application and services with the new setting.

12. Click **OK** when the restart has completed to dismiss the window.

**To Configure a Room for the VDCP Protocol**

Set up a Room to use the VDCP (Louth) protocol to control server channels.

*Note: When controlling the server from a remote device over ethernet, you must select the port on the server corresponding to the channel transport you want to send commands to. For example, channel transport A = port 8000, channel transport B = port 8001, and so on.*

1. Launch the **Mira Config** application.
   
   You may be prompted to allow the program to make changes on the computer, click **Yes**.

2. Click the **RS422** tab.
3. Click **Room X Configuration** and select the room you want to configure. Later you will assign this room to a channel.

4. In the **RS422 Protocol** area, select **VDCP**.

5. In the **Restrict to Folder** area, select if you want to restrict remote control of the selected room to only seeing the contents of a specific folder, or all folders (**All Folders**).

6. In the **Response Time** area, select how quickly the server executes the Clip Play command after the Clip Load command.
   - **Fast** — executes the play command immediately after the load command. This is recommended when controlling the server from an external switcher.
   - **Accurate** — executes the play command only after receiving confirmation that the clip has loaded. This is recommended when controlling the server from an automation system.

7. In the **Channel Control Port** area, select whether you want to use the serial ports or ethernet connection for the channels assigned to the room.

8. In the **Edit Timing** area, select a timing offset for when you are controlling the server from an external editor over serial.
   - **Timecode Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout or record.
   - **Source Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout.
   - **Out Point Offset** — select the offset, in fields, of the out-point timecode value that is sent to the editor during record.

9. In the **Video Edit Effect** area, select which tracks get recorded when an external editor issues the Video Record command to the server.
   - **Edit Video Track** — only the video track is recorded.

10. In the **VDCP Configuration** area, select specific configurations for the protocol you are using.
    - Select **Louth Preview** to allow clips to be pre-cued in the background for seamless back-to-back transitions during playout.
• Select **Allow playlists control** to allow a playlist to be cued and played from an external device just like a clip.
• In the **Maximum length of Clip Name** field, select the maximum length of a clip name that is reported to the controlling device.

11. Click on the **Ch-X** list and select the room that you want to assign to the channel.
12. Click **Restart Mira**. A confirmation dialog box is displayed.
13. Click **Restart Mira** to restart the server application and services with the new setting.
14. Click **OK** when the restart has completed to dismiss the window.

**To Configure a Room for the AMP Protocol**
Set up a Room to use the AMP protocol to control server channels.

**Note:** When controlling the server from a remote device over ethernet, you must select the port as 3811 and then select the channel you want to send the commands to.

1. Launch the **Mira Config** application.
   You may be prompted to allow the program to make changes on the computer, click **Yes**.

2. Click the **RS422** tab.

3. Click **Room X Configuration** and select the room you want to configure. Later you will assign this room to a channel.

4. In the **RS422 Protocol** area, select **AMP**.

5. In the **Response Time** area, select how quickly the server executes the Clip Play command after the Clip Load command.
   • **Fast** — executes the play command immediately after the load command. This is recommended when controlling the server from an external switcher.
   • **Accurate** — executes the play command only after receiving confirmation that the clip has loaded. This is recommended when controlling the server from an automation system.

6. In the **Edit Timing** area, select a timing offset for when you are controlling the server from an external editor over serial.
• **Timecode Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout or record.
• **Source Alignment** — select the offset, in frames, of the timecode information that is sent to the editor during playout.
• **Out Point Offset** — select the offset, in fields, of the out-point timecode value that is sent to the editor during record.

7. In the **Video Edit Effect** area, select which tracks get recorded when an external editor issues the Video Record command to the server.
• **Edit Video Track** — only the video track is recorded.

8. In the **AMP Protocol Configuration** area at the bottom of the window, select specific configurations for the protocol you are using.
• Select **Disable field timecode reporting** to force the server to report timecode only once every video frame. If this option is not selected, the server reports timecode every field.
• Select **Allow overlapped commands** to allow the server to accept overlapping commands.
• Select **Allow playlists control** to allow a playlist to be cued and played from an external device just like a clip.
• Select the **Protocol ID** that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click on the **Ch-X** list and select the room that you want to assign to the channel.
10. Click **Restart Mira**. A confirmation dialog box is displayed.
11. Click **Restart Mira** to restart the server application and services with the new setting.
12. Click **OK** when the restart has completed to dismiss the window.

**DashBoard**

The DashBoard control system allows remote access to multiple pieces of Ross Video equipment, including openGear® cards, Carbonite production switchers, Ross video servers, and Ross cameras. Download and install the latest version of DashBoard from [www.rossvideo.com/support/software-downloads/](http://www.rossvideo.com/support/software-downloads/).

Review the documentation that comes with DashBoard for information on installing and launching DashBoard.

To control Mira Express from DashBoard you must create a custom panel in DashBoard using PanelBuilder to send VDCP or Mira Express Ethernet API commands to the server.

**Note:** DashBoard can only display active video for a channel transport if DashBoard is running on the same Mira Express server. Active video for a channel transport cannot be shown in DashBoard when DashBoard is running on a separate computer.

**Abekas® DashBoard Service**

The Abekas® OGP (openGear® Protocol) Service allows you to connect to your server from DashBoard.

**To Install the Abekas® OGP Service**
The AbekasOGP application should already be installed on your server. If it is not, you can download and install the application manually.

1. Navigate to the **Downloads** section of the Ross® website for your server product and download the Abekas® OGP DashBoard Service.

   **Tip:** For example, if you have a Mira server, you would navigate to [https://www.rossvideo.com/support/software-downloads/mira/](https://www.rossvideo.com/support/software-downloads/mira/).

2. Run the Abekas_#.#.##_setup.exe application on your server and follow the wizard to install the service.

**To Connect to the Server from DashBoard**

1. Click **File > New > TCP/IP DashBoard Connect or openGear Device.**
2. In the **IP Address** field, enter the IP address of the server. The default IP address is 192.168.0.1.
3. In the **DisplayName** field, enter the name you want to use to identify the server in DashBoard. This should be a unique name for the server you are setting up.
4. Select **JSON**.
5. In the **Port** field, enter 5254.
6. Click **Finish**.

   The server appears in the **Tree View**.

### DashBoard Interface

The server appears as a node in the DashBoard Basic Tree View. The **Replay** and **Explorer** sub-nodes can be expanded to show the **Operator** and **Explorer** pages.

![DashBoard Interface](image1)

### Replay

The **Operator 1** and **Operator 2** pages are also known as **MiraTouch Horse Racing** panels and are intended to be used in a 4-in/2-out replay configuration for horse racing.

![Replay](image2)
**Explorer**
The Explorer and Explorer Touch pages mirror the operation of the Explorer application of your server. The Explorer Touch page is a smaller version designed to fit into Live Assist.

*Tip:* Portions of these pages can be dragged onto a custom panel in DashBoard PanelBuilder.

---

**Palette**
The Palette page provides a number of widgets for use in PanelBuilder.

---

**PanelBuilder Custom Panel Attributes**
When building a custom panel in DashBoard, you can connect to your server as a data source. This allows you access to numerous powerful commands and parameters native to your server.

**To Add a Server Command to a Custom Panel**
1. Double-click on the canvas of your custom panel and click the openGear or XPression DataLinq Configure button.
2. Click **Select a device** and select **Abekas**.

3. Click **OK**.

   The **Current** below the button shows the **Abekas** server.

4. Insert a button or other interface element to your custom panel.

5. Edit your interface element as normal and click **Add** in the **Tasks** area.

   You can now drag and drop Abekas® server commands to the script editor to create visual logic chains.
Clip ID Support

Devices using the VDCP or Odetics protocol can use the 8-character clip ID assigned to a clip. By default, the server does not assign a clip ID to the clip when it is recorded or imported. If there is no clip ID, the first 8 characters of the clip name are used instead.

Sony® MVS Series Switcher

Use the following information to set up your Sony® MVS series switcher to control the server as either a **Recorder** or **Player** device.

*Table 4: VDCP RS422 Protocol Constants*

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Video Port</td>
<td>(1-N)*</td>
</tr>
<tr>
<td>2</td>
<td>Maximum Open Delay</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>Maximum Cueup Delay</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Play After Cueup Delay</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Stop Delay</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>Still Delay</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Continue Delay</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>Idle Delay</td>
<td>2</td>
</tr>
</tbody>
</table>

* Set this value to the MVS virtual RS422 Port # that is connected to the server.
Maintenance

Refer to the following information for performing maintenance on your server, muting an alarm, restoring factory defaults, or upgrading the software.

Alarm

All servers feature audible alarms inside the chassis to notify the user of cooling fans and power supply failures.

The server contains both primary and redundant fans and power supplies. A failure of either of these components causes the system to alarm and to automatically switch over to the redundant item. The server will continue operating with the failed component.

You can mute the audible alarm and failure notification from the front of the server, and continue working until you are able to service the failed component.

When a failure occurs, the audible alarm sounds and the red Alarm Mute button on the front of the chassis flashes.

Tip: Lift the clear cover and press the red Alarm Mute button to silence the audible alarm. The button will continue to flash as long as the alarm state still exists.

Media Drive

The server uses an SSD media drive to store all media content.

Disk Space

The amount of free disk space that is available for clips is shown at the top of the Mira Explorer window. The free space is shown in time (HH:MM:SS:FF) and percentage of free space on the drive. When the amount of free space goes below 10% the text is highlighted in yellow. If the amount of free disk space goes below 5% the text is highlighted in red.

Tip: When the amount of free disk space goes below 5% you should consider removing unused content in order to free-up media disk space.

To assist you in locating older or unused content, the Clip Library contains Date Loaded and Date Played columns that can be used to sort content.

To Replace the Media Drive

The media drive in the server can be replaced. This is useful for increasing the amount of storage, replacing a failed drive, or moving your media library from one server to another.

Note: You can only have a single media drive in the server at a time. If you want to use multiple SSDs in the server as the media drive, you must set them up as a raid array.

1. Power off the server and disconnect the power cords from the mains power.
2. Locate the media drive at the front of the server.
3. Slide the silver tabs on the drive doors to the right to unlock the doors.
4. Pull the bay doors open and remove the drives.

ESD Susceptibility: Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the server components in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards or drives from the chassis and exercise proper grounding precautions when working on circuit boards.
5. With the connectors facing the server, slide the new drives into the slots in the server.
6. Push the bay doors closed to secure the drives in the server.

With the new media drive installed you can reconnect power to the server and turn it on. Use the Disk Management utility in Windows® to format the new drive (if required) and assign it drive letter H. A folder named Video must be located at the root directory of the media drive.

To Mount the New Disks
When you install new drives into the server, you must configure them in Windows® for them to be available to the server.

1. Open Disk Management utility.
2. Click Action and then click Rescan Disks.
3. Right-click any disk marked Foreign, click Import Foreign Disks, and then follow the instructions on your screen.

   **Note:** Ensure that Foreign disk group is selected.

4. If the new mirrored drive is not marked as drive H:, right-click on the drive and click Change Drive Letter and Paths..., and then follow the instructions on your screen.

An AutoPlay dialog box may appear after you are done mounting the new drives. Cancel (X) the dialog. The new drives are now ready to use.
AsRun Log Creator

The server keeps a log of stills and clips that have been played in their entirety on all channel of the server. This information can then be filtered and output into either a CSV file or a PDF report.

Note: Clips must be played out in their entirety to be added to the AsRun log.

The AsRun log can be filtered for a number of criteria for the media items and when or where they were played.

- **Date Range** — the range of dates that the media items was played in.
- **Channels** — the transport channels that the media items were played on.
- **Media Players** — the type of media item that was played (audio and video).
- **Media File Name** — the name of the media item that was played.

To Run an AsRun Report

Generate a PDF or CSV report of what clips and stills were played on the server.

1. Launch the AsRunReport application on your server.

2. Set the parameters and filters you want to apply to the report

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>This is the name that appears on the report.</td>
</tr>
<tr>
<td>Additional Notes</td>
<td>Add any additional notes that you want to appear on the report.</td>
</tr>
<tr>
<td>Format</td>
<td>Select how you want the report to be formatted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Aggregate</strong> — lists how many times each clip was played during the selected date range</td>
</tr>
<tr>
<td></td>
<td>• <strong>Individual</strong> — lists every instance that a clip was played, including the start and stop times, during the selected date range</td>
</tr>
<tr>
<td>Date Range</td>
<td>Set the from and to date range between which you want to generate the report.</td>
</tr>
<tr>
<td>Channels</td>
<td>Select which transport channels on the server that you want to generate the report for. Channel that are not present on your server are grayed out.</td>
</tr>
<tr>
<td>Media Players</td>
<td>Select whether you want to show only audio clips, only video clips, or both.</td>
</tr>
</tbody>
</table>
Enter a name or part of a name in the field, or leave the field blank. The clips that were played during the date range will be filtered to only include those clip names that include the **Media File Name**. If no name is specified the filter will return all clip names.

### Tip:
You can change the filter settings and click **Apply Filter** again to update the search results.

#### 3. Click **Apply Filter**.
The table below lists all the results of the filter.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Media File Name</strong></td>
<td>Enter a name or part of a name in the field, or leave the field blank. The clips that were played during the date range will be filtered to only include those clip names that include the Media File Name. If no name is specified the filter will return all clip names.</td>
</tr>
</tbody>
</table>

![Video Server AsRun Log Report Creator](image)

#### 4. Click a **Create** button to generate the report file. You are prompted for a location to save the file.
- **Create CSV** — creates a standard comma segmented value (CSV) file.
- **Create PDF** — creates a formatted PDF report file.

#### 5. Click **Exit**.
Troubleshooting

Refer to the applicable section below for information on troubleshooting the operation or setup of your server.

**Mira Explorer Problems**

- Transport control buttons (Play, Stop, etc.) are grayed out.
  - Is a play channel transport selected and active?
  - Is a clip loaded in the selected play channel?

- A play channel is selected, and a clip is loaded, but still can't control anything.
  - Are you logged in as Guest user? Guest user level may not have permission to use all transport controls. Quit **Mira Explorer**, and log back in as either Administrator or as Privileged User.

- There are clips stored on the server but they aren't listed in the Clip Library.
  - Expand the clip listing within the Clip ID column by clicking + before the server name.

- I cannot see all of the information for a given column in the Clip Library. There is a ... symbol at end of the field.
  - Expand the width of the given column.

- I cannot modify any of the clip metadata in **Clip Modify** menu.
  - Is the clip locked? Clip metadata cannot be modified on locked clips.

- I cannot see any other windows or the taskbar because **Mira Explorer** covers the entire computer screen.
  - **Mira Explorer** is in Full Screen mode. Press the F11 button on the keyboard to exit (or to enter) this mode.

- I cannot delete a clip, or cannot delete any clips.
  - Is the clip locked? Clips cannot be deleted if they are locked.
  - Do you have proper user permissions? You may not have permission to delete clips at your user level.

- I see the **Keywords** field in the **Clip Modify** menu. I can enter a keyword but I can't see the keywords in the Clip Library listing.
  - While it is possible to enter, save and search (find) keywords for all clips, the feature to display the keywords in the Clip Library is not implemented at this time.

**Mira Import Problems**

- Cannot see any remote directories when choosing the **Import From** directory, or when selecting clips to import.
  - Have you mapped the remote directory as a local disk drive?

- Video on channel is disrupted when importing media files.
  - The processing hardware for a video channel is used during media file import.

- I get a missing codec error message when importing some QuickTime® MOV files.
  - If the MOV file you are attempting to import was created with a proprietary codec (for example, with Avid® DNxHD codec), then you will need to visit the web site of the codec creator and download and install that codec on the server.
To identify which codec was used to create the MOV file, open the MOV file in the standard QuickTime® player and choose the **Window > Movie Inspector** (CTRL+i). The codec will be listed within the Source information.

Importing 525 (480i) MOV files result in 1080 clips (or vice versa).

- The importer converts all MOV files into the current video format that the server is operating in. For example, if the server is set to the 1080i 59.94, then all imported clips are converted to 1080i 59.94.
- If you want to import 525 (480i) MOV files as 525 (480i) clips, you must change the video format of the server to 525 (480i) before importing these MOV files.

**General Problems**

- Video output is not synchronized with downstream devices.
  - Check that a reference signal is connected to the Reference BNC on the back of the server and that the correct reference format is selected.

- I cannot record external timecode.
  - Check that a valid analog timecode signal is connected to the LTC IN port.
  - Verify that the timecode signal is 1V peak-to-peak minimum.

- I hear a beeping sound from inside the main server chassis.
  - Check to see if two power cords are connected to the AC input on both power supplies. If only one power cord is connected, then the internal alarm will sound. The only way to silence the alarm is to either connect AC power to both modules, or remove the module without power. Although the server can operate with just one power module, it is not recommended.
  - If the two power cords are connected to the two modules of the power supply, and you are sure there is full power on both power cords, then check the small LED on each of the two power supply modules (from the chassis rear). These LEDs should be solid green. If either LED is blinking, or has changed to yellow or red, then you may have a fault in the power supply module. Remove the suspect power supply module immediately (the alarm should then mute). Contact Ross® technical support for assistance.

  - If the power supply checks okay, check the LEDs on the media drives on the front of the server. These LEDs should be BLUE or PURPLE. If any of the LEDs are RED there may be a failed media drive. Eject the drive and re-seat the dive in the bay. If this does not clear the fault after 5-10 seconds the drive may have failed. Contact Ross® technical support for assistance.

- How do I record more than just two tracks of audio?
  - The Server comes standard with 8-track embedded audio per video channel. To record more than 2-track audio, you must enable the selection in **Mira Config** application.
Specifications

Resources, video specifications, power rating, and port pinouts.
The information in this section is subject to change without notice.

Resources

The number of resources specific to your server depends on the model.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Inputs</td>
<td>4</td>
</tr>
<tr>
<td>Video Outputs</td>
<td>2</td>
</tr>
<tr>
<td>AES Audio Inputs</td>
<td>8</td>
</tr>
<tr>
<td>AES Audio Outputs</td>
<td>8</td>
</tr>
<tr>
<td>Analog Audio Outputs</td>
<td>1</td>
</tr>
</tbody>
</table>

Operating Temperature

The system has been qualified at an operational temperature range of 13 to 35°C (55 to 95°F) and a non-condensing humidity range of 20 to 80%.

Table 5: Safe Operation and Non-operating Environmental Conditions

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>5 to 55°C (41 to 131°F)</td>
<td>-40 to 65°C (-40 to 149°F)</td>
</tr>
<tr>
<td>Relative Humidity</td>
<td>8 to 90% non-condensing</td>
<td>5 to 95% non-condensing</td>
</tr>
<tr>
<td>Max. Wet Bulb Temperature</td>
<td>29.5°C (85°F) non-condensing</td>
<td>35°C (95°F) non-condensing</td>
</tr>
<tr>
<td>Max. Temperature Gradient</td>
<td>15°C/hour (59°F/hour)</td>
<td>15°C/hour (59°F/hour)</td>
</tr>
<tr>
<td>Altitude Range</td>
<td>-300 to 2,000m (-984 to 6,566ft.)</td>
<td>-300 to 12,200m (-984 to 40,026ft.)</td>
</tr>
</tbody>
</table>

Note: Operator is responsible for providing sufficient ventilation to maintain surface temperature below 40°C (104°F) at the center of the top cover of the media drive.

Note: Non-condensing conditions should be maintained at all times.

Note: Maximum storage period inside shipping package is one year.
Ports

Serial (RS422) Port

The female DB9 serial port supports the RS-422 transmission standard.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>Tx-</td>
</tr>
<tr>
<td>3</td>
<td>Rx+</td>
</tr>
<tr>
<td>4</td>
<td>Rx-Ground</td>
</tr>
<tr>
<td>5</td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>Tx-Ground</td>
</tr>
<tr>
<td>7</td>
<td>Tx+</td>
</tr>
<tr>
<td>8</td>
<td>Rx-</td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
</tr>
</tbody>
</table>

LTC Port

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>LTC-</td>
</tr>
<tr>
<td>3</td>
<td>LTC+</td>
</tr>
</tbody>
</table>

AES Audio Port
Index

Numerics
2-Replay Channel Transition, User Setup 29
3-Point Loop 59, 61
3G Formats 13

A
Active Channel 59
Administrator 57
Administrator Account 56
Air Playlist 70
Alarm 121
AsRun 123
Audio Routers 16
Audio Setup 15
Auto Gang for Live EE, User Setup 30
Auto Jog, User Setup 24
Auto Load Clip, User Setup 32
Auto-Mark In, User Setup 28
Auto-Mark Out, User Setup 29

B
Bank 0 88
BROWSE 84

C
Camera Inputs 87
Camera Name 38
Chain 59
Channel Labels 19
Chase, Timecode 77
Child Clips 75
Clip Export 108
Clip Folders 71
Clip ID Support 120
Clip Library 68
Clip Play Mode 88
Clip Register 87
Clip Search 68
Clip, Delete 76
Clipping 97
Count Down Display, output 20
Count-Down Timer 59
Create Replay Event 90
Create Replay Event Template 93
Cruise Speed Max, User Setup 26

D
Delete Clip 76
Dim for Lists, User Setup 34
Disk Space 121
Duplicate Segment, Export 110

E
Edit Replay Event Template 93
EE 59
Eject Clip, See Unload Clip
Electronic-to-Electronic 59
Ethernet Control 111
Exit Playlist 70
Explorer 56
Export 110
Export Destination 108
Export Replay Play List 104

F
Fast Cruise Speed Max, User Setup 26
Fast Forward Speed, User Setup 25
Fast Jog Speed Max, User Setup 26
Fast-Forward 59
Favorite Replay Event 93
Find Clip 68
Folders 71
Free Disk Space 121

G
GANG Off for Channel Select, User Setup 31
GOTO TC 95
Guest User Account 56

H
HD Export Codecs 108
Headphones Left, User Setup 23
Headphones Right, User Setup 23
Headphones Volume, User Setup 23

I
Import 39, 53
AutoStart 53
Codec 53
Color Config 53
Destination 53
Multi-Screen 53
Multi-Screen File 53
Watch 53
Import Media Files 39
Initial Names, User Setup 36
ISO Channel Modes 22
ISO-1 13
ISO-2 13
ISO-3 13
ISO-4 13
J
JOG 84
Jog Forward/Reverse 59
Jog Max Speed, User Setup 25

K
Keyboard Shortcuts 65

L
Labels, Channels 19
Live EE Mode 87
LIVE-EE Select Preferred Cams, User Setup 31
Load Clip 59–60, 98
Load Clip by Number 98
Load Server Clip 94
Lock/Unlock Channel 64
Locked Clips 76
Locked, Clips 76
Loop Play 85
Loop Repeat 59, 61
Loop to Play Repeat 59, 61
Loop, Off 61
Looping 61
Looping, Play List 70

M
Maintenance 121
Mark Point 106
Mark Saved to Clip Register, User Setup 33
MARK, Edit 106
Media Drives 121
Melt Camera 104
Melt Play List 104
Melt Replay Event 104, 110
Melt, Reset Flags 105
Metadata 72
Metadata, Attributes 72
Metadata, Labels 72
Metadata, Timecode 74
Metadata, Trim 74
Mira Config 12
Mira Explorer 12
Mira Import 12
Mirrored SSD 121
Mix Transition Duration, User Setup 30
Modes 87
Modify Replay Event 90
Multi-Screen 53
Import 53
Mute Alarm 121

N
Names, User Setup 37

O
Obey Clip Out-point, User Setup 32
OGP Service 116
Operating Temperature 127
Operation Modes 87

P
Panel Brightness, User Setup 34
Panel Contrast, User Setup 34
Parent Clips 75
Personality 23, 37
Ping-Pong Repeat 59, 61
Play Forward 59
Play List 68, 87
Play List Auto Fill, User Setup 24
Play List Commands 71
Play List Mode 89
Play List Operation 99
Play List Trash Can 102
Play List, Copy/Paste 102
Play List, Create 99
Play List, Edit 99
Play List, Exit 70
Play List, Looping 70
Play List, Looping 70
Play Reverse 59
Play Speed 59
Playback 96
Playout Border Saturation, User Setup 35
Playout Channel Color, User Setup 35
Playout Channels 86
Playout Mode 88
Pre-Roll In, User Setup 24
Pre-Roll Out, User Setup 24
Pre-Roll POI, User Setup 24
Preferred Cams, User Setup 31
Preferred Playlist, User Setup 32
Privileged User Account 56
Program (PGM) 86

R
Record 59, 62
Remote Control 111
Repeat Modes 61
Replay Event, Melt 104, 110
Replay Panel, connecting 22
Replay Setup 22
Replay Window 85
Required Equipment 79
Reset Melt Flags 105
Rewind 59
Rewind Speed, User Setup 25
Rotary Dial 84
Router 14
Router Source 95
RS-422 111
S
SCROLL 84
SD Export Codecs 108
Search Clips 68
Seek End 59
Seek Start 59
Select Columns 71
Setup 13
Setup Menu 87
Setup, Replay 22
SHIFT 80
Shift Lock 80
Slider Handle 59
Softkey Buttons 80
Softkey in CP Mode, User Setup 29
Softkeys 87
Specifications 127
SPEED PRESET field 96, 104
Split Segment, Export 110
Stop 59

T
T-Bar 81
T-Bar VAR 2 Max Speed, User Setup 27
T-Bar VAR 2 Min Speed, User Setup 27
T-Bar VAR 3 Max Speed, User Setup 27
T-Bar VAR 3 Min Speed, User Setup 28
TC Chase 77
Timecode 18, 59
Timecode Chase 77
Title New Clips, User Setup 36
Trash Can, Play List 102
TSL Tallies 20

U
Unload Clip 61
Use 2 Channels for PL mode, User Setup 33
User Setup 23
User Setup File, Load 37
User Setup File, Save 37
User Setup Files 37

V
VAR 2/3 96, 104
Variable Speed 96, 104
Verify Destinations 108
Video Format 13
Vue Mark Mode 89
VUE MARKS 84